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About This Guide
Welcome! This guide describes all you need to know about using 
your Wrist PDATM watch and the applications that come with it. 

Before using your watch as a personal digital assistant (PDA), you 
may want to look at the first two chapters of this guide to learn 
about its basic features and how to write on the screen using the 
built-in handwriting software. Then see chapter 4 for details on 
using the main applications: Date Book, Address Book, To Do List, 
and Memo Pad. 

After you become familiar with your watch’s basic features, you can 
use this guide as a reference for less common tasks, and also as a 
source of information if you have problems operating the watch. 

NOTE: To set up your Wrist PDA, follow the instructions in the 
Getting Started booklet. 



About This Guide
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1
Introduction to the 
Wrist PDA Watch
To start using with your Wrist PDA, you should familiarize yourself 
with the basic features described in this chapter. You’ll learn how to:

• identify the watch’s main components

• switch to PDA mode when the time is displayed

• open and use applications

• write on the screen to enter data

• customize Wrist PDA features

• use the PalmTM Desktop software

• beam data between your watch and another PDA device

• recharge your Wrist PDA when its power starts getting low
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Wrist PDA components

Main components

Screen. Displays the applications and data stored in your watch. It 
is touch-sensitive and responds to the stylus. 

• Write letters and numbers on the screen using the built-in 
Jot® handwriting software (see page 21). 

• Activate the electroluminescent (EL) backlight by pressing 
and holding the Back button (see the next page).

Stylus. Remove the stylus from the wristband and use it as a 
selection tool (like a mouse) or to write text and numbers on the 
screen 
(see page 16).

IR port. Uses infrared technology to exchange data with other Wrist 
PDA watches and Palm devices. See "Beaming Information" on page 
107 for more information.

Stylus (built into wristband)

Infrared (IR) port

Screen
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Control buttons

Rocker switch. Pivoting the switch up or down displays the next 
item or line on the screen. 

Press inward on the switch (toward the watch) to use it as an Enter 
button. This lets you select the currently highlighted application or 
menu item. 

When the Wrist PDA watch is displaying the time, press the switch 
to return to PDA mode.

Page Up and Page Down buttons. Displays text and graphics that 
extend beyond the area of the watch screen. Lets you scroll up or 
down by moving one screen at a time. 

Back button. Lets you return to the previous screen, or exit the 
current application and return to the Application Launcher. (Press 
the Back button repeatedly to display the Application Launcher 
categories All, Main, and System.) 

Press and hold the Back button to turn on the EL 
(electroluminescent) backlight. 

Page Down
Scrolls down one screen 
at a time

Back button
• Press to go back to previous 

screen or to view applications
• Press and hold to turn on EL 

(electroluminescent) backlight

Rocker switch
• Pivot to display next item or line on 

the screen
• Push in on the button to use as Enter 

key. Selects the highlighted item. 
• When time is displayed, press to 

activate PDA mode

Page Up
Scrolls up one screen 
at a time
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Back of the watch

HotSync Pod connector port. Lets you connect the cable from the 
HotSync Pod to recharge the watch and perform HotSync® 
operations.

Reset button. Under normal circumstances, you should not have to 
reset the watch. See page 131 for more information.

HotSync Pod

The HotSync Pod lets you recharge the watch or synchronize 
information between your Wrist PDA watch and the Palm Desktop 
software using HotSync technology. Connect the cable from the 
HotSync Pod to the port on the back of the watch when recharging 
(page 24) or to perform a HotSync operation (page 111). 

Connector port (for HotSync Pod)

Reset button
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Displaying the time
Your Wrist PDA watch automatically displays the time after a brief 
period of inactivity (when you have not used the stylus or pressed 
any of the buttons). You can select the specific period of time after 
which the watch face will appear, ranging from 30 seconds to two 
minutes. See page 99 for instructions on setting the time delay.

NOTE: For ease of viewing in dark conditions, turn on the 
electroluminescent (EL) backlight. Press and hold the Back button 
on the left side of the watch until the light activates. 

See these sections for more information:

• To set the date and time, see page 96

• To select a different watch face style from various built-in 
options, see page 99

You can also install third-party applications for displaying the time, 
but they will not automatically run like the built-in watch feature. 
See page 37 for instructions on installing add-on applications. 

Switching to PDA mode
When the watch face is displayed, you can switch to PDA mode by 
pressing and holding the Rocker switch on the right side of the 
watch. 

NOTE: You can set how long you have to hold the button to 
switch to PDA mode. See page 98.

Press to activate PDA mode
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Using the stylus
The stylus is integrated into the 
wristband (for metal bands) or into a 
holder on leather or plastic bands. To 
use the stylus, slide it straight out as 
shown. 

Tapping. Tap with the stylus to select items on the screen, or to 
position the cursor in text.

If you are having trouble selecting an object, such as a button, slider, 
or checkbox, try tapping and holding the stylus on the object.

Selecting. To select a section of text, press and hold the stylus in 
place until the watch “chirps.” Then drag the stylus to the right 
along the section of text you want to select. This highlights or selects 
the text.

IMPORTANT: Do not use a pen, pencil, or any other sharp 
object to write on the screen. A spare stylus is included with the 
watch. If you misplace your stylus, visit www.fossil.com for 
information on getting a replacement. 

If you have difficulty accurately selecting items on the screen, you 
may need to calibrate the screen. See page 132. 



Introduction to the Wrist  PDA Watch
Working with applications

Wrist PDA User Guide 17

Working with applications
Your Wrist PDA watch comes with several built-in applications. The 
main ones are:

• Date Book

• Address Book

• To Do List

• Memo Pad

• Calculator

The applications are displayed as icons on the Applications 
Launcher screen, as shown:

Applications can be sorted into categories to help you find them. 
The watch comes with several built-in categories, such as Main, 
System, Games, and Utilities. You can also create your own 
categories (see "Managing Applications" on page 33). 

The watch’s main applications (Date Book, Address Book, etc.) are 
stored in the Main category. You can select a category by tapping the 
pick list in the upper-right corner of the screen:

In addition to letting you see your applications, the Applications 
Launcher screen also displays the current time and battery level. See 
page 24 for information on reading battery levels and recharging 
your watch.

Application icons

Tap here to choose 
application category
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To open an application:

1. If your Wrist PDA is not in PDA mode (for example, if it’s 
showing the time), switch it to PDA mode by pressing the Rocker 
switch on the right side of the watch (see page 15).

2. Once you’re in PDA mode, if an application is currently running, 
press the Back button to exit the application and display the 
Applications Launcher screen. 

3. Select the category containing the application you want to open.

You can select the category from the pick list in the upper-right 
corner 
(see page 17) or by pressing the Back button repeatedly to cycle 
through categories (only categories with applications in them will 
be displayed). 

TIP: If you are unsure which category an application is in, select 
the All category to display all the applications on your watch. See 
page page34 to find out which category an application is in and 
how to change it.

4. If there are more applications than fit on the screen, do one of the 
following:

• Press the Page Up or Page Down button until the desired 
application is visible. 

• Use Rocker Up or Rocker Down to move the highlight to the 
desired application.

• Use the stylus to write the first letter of the application on the 
screen; this highlights the first application that starts with 
that letter.

5. To open the application, use the stylus to tap its icon. Or if the 
icon is already highlighted, just press Rocker Enter.

To switch to another application, press the Back button on the watch 
to display the Applications Launcher screen, then select the 
application you want to open. 

NOTE: To install additional new applications, see page 37.
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Understanding application interface elements
Wrist PDA applications include the following 
interface elements:

• Pick lists that display a list of choices. Tap 
the black triangle next to the pick list to 
display a list of choices, and then tap an 
item in the list to select it.

• Text areas and screens in which you can 
enter information.

• Scroll bars to move through multi-page 
screens. Tap and hold down the scroll bar 
slider to scroll through pages; tap the slider 
arrow at the top or bottom to move one 
line at a time. To scroll to the previous 
page, tap the scroll bar just above the 
slider; to scroll to the next page, tap the 
scroll bar just below the slider. You can 
also scroll to the previous and next pages 
by pressing the Page Up and Page Down 
buttons on the right side of the watch.

• Menu bars containing drop-down 
menus specific to an application. Tap 
the application’s tab at the top-left 
corner of the screen to access the menu 
bar (not all applications have a menu 
bar).

• Check boxes that indicate the state of 
the corresponding option. A check 
mark in a check box indicates that the 
option is active. If a check box is 
empty, tapping it inserts a check mark. 
If a check box is checked, tapping it 
removes the check mark.

• Command buttons that initiate a 
command when tapped. Command 
buttons appear in dialog boxes and at the bottom of 
application screens.

Pick list

Text area

Check
box

Tap here to 
display menu bar

Command button
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Using menus and menu commands 
Menus on your watch are easy to use, and work the same way in all 
applications. Menu bars and manual commands differ based on the 
application and the area of the application in which you’re working. 
For example, in the Memo Pad, the Memo List screen and the Memo 
screen display different menus. 

Menu commands for each application are described in the 
corresponding application’s chapter, with the exception of the Edit 
menu. For information on Edit menu commands, see "Using the 
Edit menu" on page 81

Most menu commands have an equivalent command stroke, which 
is similar to keyboard shortcuts used to execute commands on 
computers. To use menu commands, menus must be closed. 

To display a menu bar and choose a command: 

1. Do one of the following: 

• Open an application (such as the Date Book); tap the tab at 
the upper-left corner of the screen (the Calculator does not 
have a tab); then tap the desired command. 

• In the text input area of the screen, drag a diagonal line from 
the lower left to upper right (called the Command stroke) to 
display the Command toolbar. The Command toolbar is 
displayed for approximately 4 seconds.

Tap an icon that represents the command you want, or write the 
ShortCut character for the command you want to use. For example, 
to choose Select All in the Edit menu, draw the command stroke in 
the text area to display the Command toolbar; then draw the letter S. 
ShortCut characters are listed beside the menu options they 
correspond to. Note that if you wait more than three seconds to 
draw the ShortCut letter, you’ll have to redraw the Command stroke 
to redisplay the Command toolbar.
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How to display tips
Many of the dialog boxes that appear on your watch contain a Tip 
icon in the upper right corner. Tips anticipate questions you may 
have and provide shortcuts for using the dialog box or other useful 
information. 

To display a tip:

1. Tap the Tips icon (the lowercase “i” in the upper right corner of 
the dialog box). 

2. Tap Done after reading the tip. 

Writing on the screen
You can write text and numbers on your Wrist PDA in two ways:

• Using the onscreen keyboard (see page 25)

• Using the built-in handwriting software (see page 26)

You can also enter data stored on your computer by importing it 
into your Palm Desktop software, and then synchronizing with 
your watch (see page 119).

Tip icon
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Customizing the watch
You can customize your watch in a variety of ways. For example, 
you can:

• Change the time zone when you travel

• Choose the delay period before the watch automatically 
displays the time

• Select a watch face style

• Change how long you have to press and hold a button to 
activate the EL backlight or cause the watch to enter PDA 
mode 

• Display the date, time, and numbers in various international 
formats

• Control the sound volume

• Set up security options

• Display owner information 

See page 95 for instructions on making these settings.

Using Palm Desktop software
Palm Desktop software includes the same main applications as your 
Wrist PDA watch: Address Book, Date Book, To Do List, and Memo 
Pad. You can use the HotSync feature of this software to back up 
and exchange data between your watch and your computer (see 
page 111).

It’s a good idea to back up your data in case something happens to 
the data on your Wrist PDA watch. Changes you make on your 
Wrist PDA watch or Palm Desktop software appear in both places 
after you synchronize.

With Palm Desktop software, you can do the following:

• Work with your Wrist PDA watch applications on your 
computer. Palm Desktop software duplicates the Date Book, 
Address Book, To Do List, and Memo Pad applications on 
your watch, so that you can view, enter, and modify any data 
stored on your watch.
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• Back up the data stored on your watch with HotSync 
technology and synchronize the data on your Palm Desktop 
software. Synchronization is a one-step procedure that 
ensures your data is always safe and up to date. See 
"Exchanging and Updating Data using HotSync Operations" 
on page 111 for more information. 

• Import and export data, so you can easily transfer data from 
other desktop applications into any of your main 
applications. See "Importing data" on page 119 for more 
information.

• Print your Date Book, Address Book, To Do List, and Memo 
Pad information on any printer.

Instructions for installing the Palm Desktop software are provided 
in the Wrist PDA Getting Started booklet. Refer to the online Help in 
Palm Desktop software for information on using the software.

NOTE: The Palm Desktop software for your Wrist PDA watch 
does not run on Macintosh systems.

Beaming data
Your Wrist PDA watch is equipped with an IR (infrared) port that 
you can use to beam information to another Palm-style device that’s 
close by and also has an IR port. 

You can send or receive the following information:

• The record currently displayed in Date Book, Address Book, 
To Do List, or Memo Pad.

• All records of the category currently displayed in the 
Address Book, To Do List, or Memo Pad applications.

• A special Address Book record that you designate as your 
business card, containing information you want to exchange 
with business contacts.

• An application installed in RAM memory.

See page 107 for details.
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Recharging the watch
A battery level indicator appears on the same 
screen as your applications: 

To avoid losing data, always recharge your 
watch before the power runs out completely. 

NOTE: If the watch ever fully discharges and you lose data, you 
can always get back your most recent data by performing a 
HotSync operation between the watch and the Palm Desktop 
software (see page 111).

To recharge the watch:

1. Make sure the power supply for the HotSync Pod is plugged into 
a power outlet and connected to the port on the back of the 
HotSync Pod as shown below:

2. Turn the watch over and connect the cable from the HotSync Pod 
to the port on the back of the watch.

3. Let the watch charge for several hours or overnight to recharge the 
battery fully. 

Battery level
indicator

Connect power supply here
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2
Writing on the 
Screen
You can enter data into your Wrist PDA watch by using the 
onscreen keyboard or by writing with the stylus in the text input 
area. You can also import data from another application (see page 
119).

Using the onscreen keyboard
Some applications let you open the onscreen keyboard anytime you 
need to enter text or numbers on your watch. 

To use the onscreen keyboard:

1. Open an application that supports using the keyboard (such as 
the Address Book, Date Book, or To Do list). 

2. Tap any record, or tap New.

3. Tap in the area where you wish to enter text. Make sure the 
blinking text entry cursor is visible.

4. To display the keyboard, open the application menu by tapping 
the tab in the upper-left corner of the screen. Select Edit, then 
select Keyboard. 

You can also open the keyboard by drawing the Command stroke 
and tapping the ABC keyboard icon on the Command toolbar (see 
page 20). 
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NOTE: To display the keyboard, a blinking text entry cursor 
must be visible in the text entry area. 

5. To display the number keyboard, tap 123 at the bottom of the 
keyboard display. To use international characters, tap Int’l. 

6. Tap the desired characters or numbers; then tap Done to enter the 
text or numbers. 

Using the handwriting software
Your watch lets you write on the screen using Jot® handwriting 
software. This lets you create letters, numbers, punctuation, and 
symbols, including all of the characters found on a standard 
keyboard. 

The strokes are different from those used on other Palm Powered 
handhelds. Jot lets you write more naturally, using standard upper- 
and lowercase printed letters in most cases. Jot recognizes various 
strokes as well as most Graffiti®-based characters. 

Backspace

Carriage return

Tab

Caps Lock

Caps Shift

Tap here to display al-
phabetic keyboard 

Tap here to display 
numeric keyboard. 

Tap here to display 
international keyboard. 

Alpha 

Numeric International

Various ways of writing the letter A. 

Use the method most natural for you.
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NOTE: Uppercase letters are formed by drawing a character 
stroke across the middle of the screen, not by drawing a character 
stroke that looks like an uppercase letter. See page 28. 

Learning to write characters
With only a few minutes of practice, you’ll find it easy to enter 
accurate text and numbers using Jot.

The Jot tutorial shows you how to use the handwriting software. To 
practice using Jot, tap the Jot application icon, then tap Tutorial. 
Tap a letter to see how it’s written, then try writing it yourself.

General Guidelines for Jot Writing
Follow these guidelines to learn and use Jot writing strokes 
successfully: 

• To achieve 100% accuracy, practice drawing characters 
exactly as they appear in the tables later in this chapter.

• The heavy dot on each shape indicates 
where to start the stroke. Some characters 
have similar shapes, but different starting 
and ending points. Always start the stroke 
at the heavy dot. (Do not draw the heavy 
dot; it is there only as a guideline.) 

• The Jot writing strokes for letters closely resemble letters of 
the standard English alphabet, both uppercase and 
lowercase. Most characters require only a single stroke. 
When you lift the stylus from the text input area, your watch 
recognizes and displays the text character immediately.

For multi-stroke characters, a temporary character is 
displayed after the first stroke, to show that the stroke was 
recognized. For example, after the first vertical stroke of “t”, 
a temporary “l” is shown. There is a short time delay, during 
which the second stroke must be drawn. Otherwise the 
temporary stroke is recorded.

Begin stroke here
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• The screen is divided into two parts, one for writing 
lowercase letters and one for writing numbers. To have your 
watch recognize letters and numbers, you must begin letter 
strokes on the left side, and number strokes on the right. 

NOTE: To turn on the screen-dividing mark (shown below), 
open the Jot application and select Show mode mark.

• Jot writing automatically capitalizes the first letter of a new 
record or sentence. To write additional capital letters, use the 
same character stroke as for a lowercase letter, but start the 
stroke on the left side of the screen and write across the 
middle, indicated by the dividing mark shown above. 

To write Jot letters:

1. Tap the screen where you want to write text, for example, on a line 
next to a time in the Date Book. 

NOTE: A blinking cursor must appear onscreen in the writing 
area before you can begin writing text. 

2. Use the tables on the following pages to find the stroke shape for 
the letter you want to write. For example, the stroke shown below 
creates the letter n. 

Write lowercase
letters on this side

Write numbers 
on this side

Dividing mark
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You use the same shape to create both the lowercase letter in the left 
hand side of the text input area, and the uppercase letter across the 
division line.

3. Position the stylus in the left hand side of the text input area. 

4. Start your stroke at the heavy dot, and draw the stroke shape as it 
appears in the tables.

5. Lift the stylus from the screen at the end of the stroke shape.

6. Your watch recognizes your stroke immediately and displays the 
letter at the insertion point onscreen. As soon as you lift the stylus 
from the screen, you can begin the stroke for the next character 
you want to write.

Jot tips
When using Jot writing, keep the following tips in mind:

• For greater accuracy, draw letters with large strokes; strokes 
that nearly fill the text input area are easily interpreted. 

• To delete characters, set the insertion point to the right of the 
character you want to delete, and draw the Backspace stroke 
(a line from right to left) in the text input area.

• Write at natural speed. Writing too slowly can produce 
errors.

• Do not write at a slant (like italics). Keep vertical strokes 
parallel to the sides of the text input area.

• When letters and numbers can be written using two different 
strokes, use the one that’s easier for you. 

• Press firmly.

Start stroke at 
heavy dot.

Lift stylus here.
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The Jot alphabet
Draw the following letters, symbols, and gestures on the left side of 
the screen.

Writing numbers
Draw the following numbers and synbols on the right side of the 
screen.

Writing accent marks
Write accent marks on the right side of the screen after writing an 
upper- or lowercase character.
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Using the Jot tuner
The Jot tuner provides alternative strokes for making the I, K, P, T, Y, 
and $ characters. For example, you may want to form the letter “T” 
by using strokes similar to a space and an “L”. But if this technique 
is difficult to control, you can turn off this option.

To use the tuner:

1. In the pick list in the upper right corner of the screen, tap All.

2. Tap on the Jot icon.

3. Tap Tuner. 

4. Tap on one of the letters available for you to tune. 

Using ShortCuts
ShortCuts let you quickly and easily enter commonly used words or 
phrases. ShortCuts are similar to the Glossary or Autotext features 
of some word processors. Jot writing comes with several predefined 
ShortCuts. You can also create your own, for any words, letters, or 
numbers.

You can create ShortCuts, with up to 45 characters, using the 
ShortCut preferences. For example, you could create a ShortCut for 
your name or for the header of a memo. All ShortCuts you create 
appear on the list in the ShortCut Preferences screen, are available in 
any of your watch applications, and are backed up on your 
computer when you perform a HotSync operation.

Your watch includes the following predefined ShortCuts for 
common entries:

To use a ShortCut:

Draw the ShortCut stroke, followed by the 
ShortCut character or characters. When you draw 
the ShortCut stroke, the ShortCut symbol appears 
at the insertion point.

• ds—Date stamp

• ts—Time stamp

• dts—Date/time 

• br—Breakfast

• lu—Lunch

• di—Dinner

• me—Meeting

ShortCut 
stroke
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To create a ShortCut:

1. Select All or System from the pick list in the upper right corner.

2. Select Prefs from the menu.

3. Tap ShortCuts in the pick list in the upper right corner. 

4. Tap New.

5. In the ShortCut Name line of the ShortCut Entry screen, enter the 
letters you want to use to activate the ShortCut.

6. Tap the ShortCut Text area, then enter the text that will appear 
when you write the ShortCut characters. 

7. You can add a space character after the last word in your ShortCut 
text, so that a space automatically follows the ShortCut text.

8. Tap OK.

To edit a ShortCut:

1. In the ShortCut Preferences screen, tap the ShortCut you want to 
edit.

2. Tap Edit.

3. Make the changes you want; then tap OK.

To delete a ShortCut:

1. In the ShortCut Preferences screen, tap the ShortCut you want to 
delete.

2. Tap Delete; then tap Yes.

Tap New.
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3
Managing 
Applications
This chapter explains how to switch between applications on your 
Wrist PDA, how to personalize application settings, and how to 
categorize applications into related groups. 

Using the Applications Launcher
The Applications Launcher displays all the available applications on 
your watch. You can also display only selected applications by 
arranging applications into categories. 

To open the Applications Launcher:

If the watch face is currently displayed, press Rocker Enter to 
display the Applications Launcher. 

Selecting applications
Your Wrist PDA watch is equipped with a variety of applications. 
All the applications installed on your watch appear in the 
Applications Launcher. 

Application icons

Application category
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In addition to providing a way for you to open applications, the 
Applications Launcher displays the current time, battery level, and 
application category. 

To open an application:

Choose from the following options:

• Tap the icon of the application you want to open. If you have 
many applications installed on your watch, you may need to 
select the category containing that application (see below). 

• If there are more applications than fit on the screen, you may 
need to scroll up or down using the Page buttons or Rocker 
switch until you see the desired application. You can also use 
the stylus to write letter with which the application’s name 
begins; this highlights the first application starting with that 
letter.

• To switch between applications, press the Back button on 
your watch and select another application in the 
Applications Launcher. 

See page 18 for more information on selecting and opening 
applications.

Categorizing applications
The category feature enables you to manage the number of 
application icons that appear onscreen in the Applications 
Launcher. You can assign an application to a category and then 
display a single category or all your applications. 

To categorize an application: 

1. If necessary, press the Rocker switch to display the Applications 
Launcher. 

2. Tap the tab in the upper-left corner to display the menu bar. 

3. From the App menu, tap Category. 
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4. Choose from the following options: 

• To choose a category for an application, tap the pick list next 
to each application.

• To create a new category for an application, tap Edit 
Categories from the application’s pick list. Tap New, enter 
the category name, and then tap OK to add the category. Tap 
OK.

5. Tap Done.

To display applications by category: 

1. Tap the pick list in the upper right corner of the screen.

2. Tap the category you want to display.

To view all the applications installed on your watch, select the All 
category.

Changing the Applications Launcher display
By default, the Applications Launcher displays applications as large 
icons. As an alternative, you can display applications as smaller 
icons or in a list format. 

To change the view of applications: 

1. Tap the tab in the upper-left corner to display the menu bar. 

2. From the Options menu, tap Preferences. 

3. From the View By option, select Small List, Small Icon, Large List, 
or Large Icon.

4. Tap OK to see your applications in the new format. 

In addition to displaying applications by icon or list, you can set an 
option to display the last-selected application and/or category of 
applications each time you open the Applications Launcher. 



Managing Applicat ions
Setting preferences for applications

36 Wrist PDA User Guide

To display the last-selected application or category:

1. Tap the tab in the upper-left corner to display the menu bar. 

2. From the Options menu, tap Preferences. 

3. In the Preferences dialog box, tap Remember Last Application or 
Remember Last Category.

4. Tap OK. Each time you return to the Applications Launcher, the 
last application or category of applications you selected is 
displayed. 

NOTE: If you do not select the Remember Last Category option, 
all applications are displayed when you select the Applications 
Launcher. 

Setting preferences for applications
You can set preferences for individual applications in the 
Preferences dialog box. Not all applications have preference 
settings. 

To set preferences for an application: 

1. Open an application.

2. Tap the Menu icon. 

3. From the Options menu, select Preferences.

4. Enter the desired preference settings; then tap OK.
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Installing add-on applications
In addition to the applications that came with your watch, you can 
install applications (called add-on or third-party applications) using 
the Install Tool during a HotSync operation. A variety of third-party 
applications are available for your device, such as games and other 
software. 

Add-on applications reside in RAM memory and can be removed at 
any time; for information, see “Removing applications” later in this 
chapter.

Installing games

In addition, you can install games included with your Palm Desktop 
software. These games (located in your Palm\Add-on folder) 
include:

• Giraffe (a fun, simple way to practice Jot writing)

• HardBall

• MineHunt

• Puzzle 

• SubHunt

After you install and start a game, its instructions appear in the 
Game menu. Depending on the game, the Game menu may also 
contain commands to show high scores, start a new game, or set 
preferences for the game.
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To install add-on applications on your watch:

NOTE: Some software publishers use an installer program to 
automate the installation of the application. In these cases, you 
may not need to follow these steps. Always follow the installation 
instructions that come with the software program. 

1. Copy or download to your computer the application you want to 
install. If the application is compressed (for example, in a .zip 
file), extract it from the compressed file. (See the software 
publisher’s instructions for details.)

2. Double-click the Palm Desktop icon on your computer desktop to 
open the application; then click Install. 

TIP: You can also open the Install Tool dialog box by double-
clicking any file with a PRC file extension.
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3. In the User drop-down list, select the user name that corresponds 
to your Wrist PDA watch; then click Add. 

4. Browse to the folder on your computer where you saved or 
extracted the application. Select the application, then click Open. 
The file appears in the Palm Install Tool dialog box. 

5. If you decide not to install an application, select it in the list of 
files in the Palm Install Tool dialog box and click Remove. The 
application is removed from the dialog box list, but not from your 
computer. 

6. Click Done. A message appears to indicate that the application or 
applications will be installed the next time you perform a 
HotSync operation. 

7. Perform a HotSync operation to install the applications. See 
"Exchanging and Updating Data using HotSync Operations" on 
page 111 for more information.



Managing Applicat ions
Removing applications

40 Wrist PDA User Guide

Removing applications
You can remove add-on applications, patches, and extensions from 
your watch if you run out of memory or no longer need them.

You cannot remove the built-in applications that reside in the ROM 
portion of your device, including the Date Book, Address Book, To 
Do List, Memo Pad, and Calculator applications.

To remove an add-on application: 

1. Tap the tab in the upper-left corner of the screen to display the 
menu bar. 

2. From the App menu, tap Delete.

3. In the Delete dialog box, tap the application you want to remove. 

4. Tap Delete.

5. Tap Yes.

6. Tap Done.

1.7M of 1.8M
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4
Working with 
Applications
Your Wrist PDA watch includes the following basic applications:

• Date Book

• To Do List

• Address Book

• Memo Pad

• Calculator

Overview of basic applications 
The Wrist PDA includes the following basic applications: the Date 
Book, for scheduling; the To Do List, for reminding you of tasks you 
need to complete; the Address Book, for entering names and 
addresses; the Memo Pad, for jotting notes; and the Calculator, for 
performing mathematical calculations.
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Using the Date Book
The Date Book lets you quickly and easily schedule appointments 
or any activity associated with a date or date and time. When you 
open the Date Book, the current date and a list of times for a 
standard business day are displayed. 

Use the Date Book to: 

• Schedule events: timed events, which have both times and 
dates; untimed events, for example, birthdays or 
anniversaries; repeating events, such as a weekly meeting 
held on the same day at the same time; continuous events, 
such as a vacation or three-day conference; and all day 
events, which reflect the default hours of a day as set by the 
user. 

• Display your schedule in different ways: by Day, Week, 
Month, or Agenda view. 

• Set an alarm to sound minutes, hours, or days before a 
scheduled appointment. 

• Attach notes to events to describe or clarify Date Book 
entries. 

• Rearrange or delete events from your schedule.

To open the Date Book:

1. Make sure you’re in PDA mode (see page 15). Then, if necessary, 
press the Back button to display the Applications Launcher. 

2. Tap the Date Book icon.

Scheduling events
An entry in the Date Book is called an event. When you schedule an 
event, its description appears on the time line, and its duration is set 
to 1 hour by default. You can easily change the start time and 
duration for any event. You can schedule the following types of 
events in the Date Book:

• Timed events, such as meetings, that have a specific date and 
a specific start and end time. 

• Untimed events, such as birthdays, holidays, and 
anniversaries. These events occur on a particular date but 
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have no specific start or end times; they appear at the top of 
the list of times marked with a diamond. You can schedule 
more than one untimed event on the same date. 

• Repeating events, such as a weekly meeting that is held on the 
same day at the same time each week. 

• Continuous events, such as a vacation or three-day 
conference.

• All day events, which reflect the default length of the day as 
set by the user. 

Scheduling timed events

You can schedule timed events for the current date or for future 
dates. 

To schedule a timed event for the current date:

1. Press the Date Book button on your watch to open the Date Book 
to today’s schedule. The current date and a list of times for a 
normal business day are displayed in Day view.

2. With the current day selected, tap the line next to the time that 
corresponds to the start of the event.

Use the Page Up and Page Down buttons to view times that do not 
fit on the screen.

3. Enter a description of the event, up to 255 characters in length.

Time bar 
shows default 
duration.

Tap a line next to 
desired time; 
then enter text.
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4. Set the event’s duration:

• If the event is 1-hour long, skip to the end of this procedure.

• If the event is longer or shorter than an hour, tap directly on 
the time to open the Set Time dialog box.

TIP: You can open the Set Time dialog box by making sure no 
event is selected, and then writing a number (to select a start 
time) on the number input side of the screen.

5. Set the duration of the event in either of the following ways:

• Tap the Start Time box and set the time by selecting the hours 
and minutes in the time columns; Tap End Time, then tap the 
time columns to set the End Time.

You can also select the time using the watch buttons: press 
Rocker Up and Down to change the hours and Page Up and 
Down to change the minutes. Pressing and holding the buttons 
makes the time change faster. Once the desired time is selected, 
press Rocker Enter to accept the changes. 

• Tap All Day if the event lasts all day. The default hours of a 
standard business day are set by the user, and may be 
changed using the Preferences command in the Date Book 
application. See the section “Changing the displayed Start 
and End Times” later in this chapter.

• Tap No Time if the appointment does not have a specific 
starting and ending time. This can be used to remind you of 
important events and holidays without creating a timed 
appointment (see page 45).

Tap the time to 
display the Set 
Time dialog 
box.
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6. Tap OK.

To schedule a timed event for another date:

1. Select the date you want in one of the following ways: 

• Tap the desired day of the week in the date bar at the top of 
the screen. If necessary, tap the Previous week or Next week 
scroll arrows to move to another week.

You can also use the Rocker switch to change the day of the 
week. You can change weeks by scrolling to before Sunday or 
after Saturday.

• Tap Go To at the bottom of the screen to open the Go To Date 
dialog box. Select a date by tapping a year, month, and day in 
the calendar.(You can also use the Rocker switch and Page 
buttons to change the month.) Tapping the day you want to 
make the appointment for automatically returns you to Day 
View.

2. After locating the desired date, follow the steps for scheduling an 
event for the current day.

Scheduling untimed events

You can schedule untimed events for any date. Untimed events 
appear at the top of the list of times marked with a diamond. 

To schedule an untimed event: 

1. Select the event date you want, as described in the previous 
procedure, “To schedule a timed event for another date.” 

Start Time
highlighted

Tap to scroll to 
earlier hours.

Tap to scroll to later 
hours.

Tap to change 
hours.

Tap to change 
minutes. 
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2. Tap New.

3. In the Set Time dialog box, tap No Time. 

4. Enter a description of the event.

5. Tap a blank area on the screen to deselect the untimed event.

NOTE: If you create a timed event and later want to make it an 
untimed event, tap directly on the event time on the Date Book 
screen; then tap No Time. 

Scheduling repeating or continuous events 

The Repeat function lets you schedule events that recur at regular 
intervals or extend over a period of consecutive days. Repeating 
events include a birthday and a weekly guitar lesson that falls on 
the same day of the week and the same time of day. Continuous 
events might include a business trip or a vacation.

New
untimed

event
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To schedule a repeating or continuous event:

1. Tap the event (be sure to tap the event and not the time next to the 
event). 

Typically, a continuous event is an untimed event.

2. Tap Details.

3. Tap the Repeat box to open the Change Repeat dialog box.

4. Tap Day, Week, Month, or Year to set how often the event repeats 
(or use the Rocker switch to select the desired option). Choose 
Day for a continuous event.

5. Enter a number that corresponds to how often you want the event 
to repeat on the Every line. 

For example, if you select Month and enter the number 2, the 
event repeats every other month.

6. To set an end date for the repeating or continuous event, tap the 
End On pick list and tap Choose Date. Use the date picker to 
select an end date.

7. Tap OK. An icon that represents a repeating event appears to the 
far right on the event line.

Making changes to repeating or continuous events

When changes are made to a repeating or continuous event you 
have the option of applying the change to just the current event, the 
current event and all future occurrences of this event, or all 
occurrences of this event - past, present, and future.

To delete repeating events:

1. Select the event you want to delete.

Tap the 
Repeat 
box.
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2. Tap Details. The Event Details screen opens.

3. Tap Delete. The Repeating Event screen opens asking for 
confirmation of the delete. 

4. Select one of the following options:

• Current deletes a single occurrence of this event

• Future deletes the current event and all future occurrences of 
this event

• All deletes all past, current, and future occurrences of this 
event.

The event is removed from your datebook and you are returned to 
the day view where you started. These steps apply to all changes 
you make to repeating or continuous events.

About scheduling repeating or continuous events

Keep the following in mind when scheduling repeating or 
continuous events:

• If you change the start date of a repeating event, your watch 
automatically changes the end date to maintain the duration 
of the repeating event.

• If you change the repeat interval (e.g., daily to weekly) of a 
repeating event, past occurrences (prior to the day on which 
you change the setting) are not changed, and your watch 
creates a new repeating event.

• If you change the date of an occurrence of a repeating event 
(e.g., from January 14 to January 15) and apply the change to 
all occurrences, the new date becomes the start date of the 
repeating event. Your watch adjusts the end date to maintain 
the duration of the event.

Tap 
Delete
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• If you change other repeat settings (for example, time, alarm, 
private) of a repeating event and apply the change to all 
occurrences, your watch creates a new event. The start date 
of this new event is the day on which the setting is changed. 
Past occurrences (prior to the day of the change) are not 
changed.

• If you apply a change to a single occurrence of a repeating 
event (e.g., time), that occurrence no longer shows the Repeat 
icon.

Rescheduling events

You reschedule events using the Details option in the Date Book. 
You can also use the Details option to convert untimed events into 
timed events. 

To reschedule an event:

1. Tap the event you want to reschedule.

2. Tap Details.

3. To change the time, tap the Time box, then select a new time. 
Press the Enter button on the right side of the watch, or press the 
Back button to cancel. 

4. To change the date, tap the Date box, select a new date, and then 
tap OK.

Adding Address Book information to an event
You can add a name and telephone number to an event using the 
Phone Lookup option. 

1. Tap the tab in the upper-left corner of the screen to open the menu 
bar. 

2. From the Options menu, select Phone Lookup. 

3. Choose the phone number you want to include and tap Add. 

Using the alarm
The Alarm setting lets you set an audible alarm for events in your 
Date Book, and display a reminder message onscreen. For untimed 
events, you can set a silent alarm that displays a blinking indicator 
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(you can tap the indicator to view the reminder message). If you do 
not set an alarm, no visual or audible indicator will occur. 

Setting an alarm for an event

You can set an alarm for minutes, hours, or days before an event. 
When you set an alarm, an Alarm icon appears to the far right of the 
event with the alarm. You set silent alarms for untimed events in the 
same way, but instead of an sounding an audible alarm, the watch 
displays a blinking indicator in the upper-left corner of the screen 
(see “Understanding the blinking alarm indicator” below). 

The alarm triggers at the specified period of minutes, hours, or days 
before the event begins. For untimed events, the indicator appears 
before midnight of the day on which the untimed event occurs. For 
example, if you set a 5-minute alarm for an untimed event that 
occurs on January 17, the blinking indicator will appear at 11:55 
p.m. on the night of January 16. 

To set an alarm for an event:

1. Tap the event to which you want to assign an alarm.

2. Tap Details.

3. Tap the Alarm check box to select it.

4. The default setting, 5 Minutes, appears (the alarm will sound 5 
minutes before the event). 

To change this setting:

• Select the 5 next to the Alarm check box and write in any 
number from 0 to 99.

• Tap the pick list to change the time unit; select Minutes, 
Hours, or Days.

5. Tap OK.

Tap here to 
select unit of time.

Enter number of 
time units here.
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Using alarm options

You can automatically cause the alarm to be set for each new event 
using preferences. You can also select a tone for the alarm and the 
number of times the alarm sounds. 

To set alarm options:

1. To open the Preferences dialog box, do one of the following: 

• Tap the inverted tab at the top of the Date Book screen to 
display the menu bar.

• In the text input area, drag a diagonal line from the lower left 
to upper right to display the Command toolbar. Type an R, 
the ShortCut for the Preferences command.

2. In the Options menu, tap Preferences.

3. Select from the following options: 

• Tap Alarm Preset to set an alarm for each new event 
automatically. The silent alarm for untimed events is defined 
by minutes, days, or hours before midnight of the date of the 
event. 

• Tap the Alarm Sound pick list, and then tap an option to set 
the tone of the alarm. Options include Alarm, Alert, Bird, 
Concert, Phone, Sci-fi, and Wake Up.

• Tap Remind Me to define how many times the alarm 
sounds—one, two, three, five, or ten times.

• Tap Play Every to set how often the alarm sounds—every 
minute; or every 5, 10, or 30 minutes.

4. Tap OK.
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Using the alarm in watch mode

When your Wrist PDA is in watch mode, the 
alarm will still run. An alarm icon will 
appear on the watch face in the upper-left 
corner of the screen to let you know that the 
alarm is active. When the alarm sounds, the 
watch will beep if you have the Alarm sound 
turned on. 

To answer the alarm while in watch mode, 
wake your Wrist PDA by pressing Rocker 
Enter. This switches the watch to PDA mode 
and lets you dismiss the alarm or use the 
Reminders list screen, as described below.

Dismissing the alarm 

Audible alarms sound for about two seconds, but you can interrupt 
the sound by tapping anywhere on the screen or by pushing any 
button. 

For a silent alarm (for untimed events), the blinking indicator 
remains onscreen until you tap it to view the Reminders list screen, 
then clear any events on the screen (see “Using the Reminders list 
screen” below).

When an audible alarm sounds, you see the Reminder screen:

This screen has three buttons for responding to an alarm:

OK: Makes the reminder go away, with no further notification.

Snooze: Switches to the application that was running when the 
alarm went off, and returns to the Reminder screen after five 
minutes. You cannot change this time interval, but you can go back 
to the Reminder screen right away by tapping the blinking indicator 

Alarm icon
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in the upper-left corner of the screen (see “Understanding the 
blinking alarm indicator” below). 

Go To: Lets you see details of the event in the Date Book. This 
cancels the alarm, and there is no further notification.

Using the Reminders list screen

The Reminder screen changes to a Reminders list of items that 
require your attention if you did not dismiss or snooze an alarm for 
one event, and another alarm sounds for a second event. If there is a 
blinking indicator in the upper-left corner of the screen, tapping it 
also displays the Reminders list (see “Understanding the blinking 
alarm indicator” below). 

Each listed reminder contains the date and time of the event, with a 
description beneath it. 

Tapping on the text or icon goes to that item in the Date Book and 
deletes the event from the Reminders list screen.

Tapping the check box clears that item, similar to a To Do list item. 
The watch will draw a line through the text, pause for a moment, 
and them remove the item from the list, although the original data 
remains in the Date Book.

The Reminders list screen has three buttons:

Snooze: Puts the Reminders list screen to sleep for five minutes. 
After this time interval, the Reminders list screen is displayed again. 
You can go directly to the Reminders list screen without waiting, by 
tapping on the blinking alarm indicator. See “Understanding the 
blinking alarm indicator” below.
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Done: If the Reminders list appeared because of more than one 
alarm, tapping Done closes the Reminders list screen, although the 
events will remain in the Date Book. The Reminders list screen will 
not appear again, unless you tap the blinking alarm indicator in the 
menu bar.

If you tapped the Snooze button and then tapped the blinking alarm 
indicator to make the Reminders list reappear, then tapping Done 
makes the Reminders list continue to snooze, and it will reappear 
after five minutes.

Clear All: removes all of the items from the list, but does not close 
the Reminders screen. Tap this button to erase a list of events that 
have passed. 

Understanding the blinking alarm indicator

A blinking alarm indicator appears in the upper left corner of the 
screen in the menu bar if:

• You tap the Snooze button 

• You tap Done in the Reminders list screen 

• A silent alarm has occurred

The indicator appears in two different states:

• Blinking star: When there is at least one item in the list, 
the star indicator blinks on and off until the list has been 
emptied.

• Blinking starburst: When a silent alarm occurs, a 
starburst pattern appears, alternately flashing solid, 
exploded, then off, until you view the new event.

Tapping on the indicator opens the Reminders list, even if there is 
only one item in the list.

Changing the Date Book view
The Date Book includes four views for displaying your 
appointments: day view, week view, month view, and agenda view. 

To display the Date Book views: 

1. Tap a view icon in the upper-right area of the Date Book screen:
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You can also press Rocker Enter to cycle through the different Date 
Book views.

To display the current time:

To display the current time in Date Book, tap and hold for one 
second on the date displayed in the upper-left corner of the screen. 
Then, without taking the stylus off the screen, make a small stroke 
in any direction away from the date display. The current time 
displays instead of the date until you release the stylus from the 
screen. 

Working in Week view

Week view displays a calendar of your events for an entire week. 
This view lets you quickly review your appointments and available 
time slots. In addition, the graphical display helps you spot 
overlaps and conflicts in your schedule.

To display the Week view:

1. Tap the Week view icon—or press Rocker Enter until the Week 
view icon is highlighted. 

2. Tap the left and right navigation controls to move forward or 
backward a week at a time, or tap on a specific day to display the 
details of an event. You can also use Rocker Up and Down to 
change the displayed week, and the Page buttons to scroll through 
the hours.

NOTE: The Week View also shows untimed events and events 
before and after the range of times displayed.

Date Book view icons

Week view
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3. Tap an event to display a description of the event at the top of the 
screen.

Tips for using Week view

Keep the following points in mind when using Week view: 

• To reschedule an event while in Week view, tap and drag the 
event to a different time or day.

• Tap a blank time on any day to move to that day and have 
the time selected for a new event. 

• Tap any day or date that appears at the top of the Week view 
to move directly to that day without selecting an event.

• The Week view displays the hours of the day defined by the 
Start Time and End Time in the Date Book Preferences 
settings. If you have an event before or after this time span, a 
bar appears at the top or bottom of that day's column. Use 
the onscreen scroll arrows to scroll to the event.

Previous
week

Next 
week

Scroll to view earlier or later events

Bar indicates earlier event.

Bar indicates later event. 

Dot indicates untimed event.

Event details

Tap to show event details.
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Spotting event conflicts

It is possible to schedule events that overlap (an event that starts 
before a previous one finishes).

An event conflict (time overlap) appears in the Week view as 
overlapping time bars and in the Day view as overlapping brackets 
to the left of the conflicting times.

Event 
conflicts
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Working in Month view

The Month View screen shows which days have events scheduled. 
Dots and lines in the Month view indicate events, repeating events, 
and untimed events.

You can control the dots and lines that appear in the Month View. 
See "Changing the Date Book display" on page 60 for more 
information.

Tips for using Month view

Keep the following points in mind when using the Month view: 

• Tap a day in the Month view to display that day in the Day 
view, or tap the scroll arrows in the lower-right corner to 
move forward or backward a month. Or tap Go To to open 
the date selector and select a different month.

• You can also use the Page buttons to change the displayed 
month, and Rocker Up and Down to highlight a different 
day. Pressing Rocker Enter changes to the Day view for the 
selected day.

Dots on right side indicate events

Dashed line indicates continuous event

Dots below date indicate untimed events



Using the Date Book

Wrist PDA User Guide 59

Working in Agenda view

The Agenda view lets you view appointments, untimed events, and 
To Do List items in a single screen. Although it is primarily a 
viewing option, you can also use the Agenda view to check off 
completed To Do List items. To go to a Day View of any event on the 
Agenda view screen, simply tap the desired event. 

To display the Agenda View:

1. Tap the Agenda view icon—or press Rocker Enter until the 
Agenda view icon is highlighted.

2. Use the navigation bars to move forward or backward a day at a 
time or to display more To Do items.

Or use Rocker Down to scroll through the list of appointments for 
the day. When you reach the last appointment, your selection will 
move to the first To Do item for the day. You can highlight a To Do 
item and then press and hold Rocker Enter to check or uncheck it 
without leaving Agenda view.

Use Rocker Up to scroll back up to the top of the To Do list and then 
to the Appointments list.

Agenda view

Scroll each list 
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Tips for using Agenda view

• Tap any appointment while in Agenda view to display the 
Day View of the appointment. 

• Check off completed To Do List items in the Agenda view, or 
click a description of an item to go directly to the To Do List 
application. Pressing the Back button returns you to the 
Agenda view.

• You can change the category of To Do items shown. Tap on 
the pick list and select the new category. See the chapter on 
“Using the To Do List” for more information on To Do items.

Changing the Date Book display
In Day or Month view, you can change which events appear in the 
Date Book. In Day view, you can display time bars that highlight 
event conflicts.

To change the Date Book display of events:

1. In Day view or Month view, tap the date in the top-left corner to 
display the menu bar.

2. Tap Options, and then tap Display Options.

3. For Day view, select from the following options:

• Tap Show Time Bars to display time bars showing the 
duration of an event and any event conflicts.

• Tap Compress Day View to display start and end times for 
each event, but no blank time slots at the bottom of the 
screen, to minimize scrolling. Clear the option to display all 
time slots. 
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4. For Month view, select whether to display Timed, Untimed, or 
Daily Repeating events.

5. Tap OK.

Changing the displayed Start and End Times

You can change the preferences used for new entries. Preferences 
include display starting time, display ending time, and alarm 
characteristics. See the section “Using alarm options” earlier in this 
chapter for more information on alarm preferences.

To change the start and end time in the Date Book:

1. Tap the date in the top-left corner to display the menu bar.

2. Tap Option, and then tap Preferences.

The Start and End Time are used by the various Date Book screens. 
The Day view schedules events to start and end at these times when 
the All Day option is selected. The Week view displays the time 
span defined by the Start Time and End Time.

3. Press Rocker Up and Down to change the start time, then press 
Page Up and Down to change the end time. You can also tap Start 
Time and use the scroll arrows to select a new start time for the 
Date Book screens, and do the same to set a new end time. If the 
time slots you select do not fit on one screen, you can tap the scroll 
arrows to scroll up and down.

4. Tap OK or press Rocker Enter when done.
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Using the To Do List
The To Do List is a convenient place to create reminders and 
prioritize the things that you have to do.

Use the To Do List to: 

• Make a quick and convenient list of things to do.

• Assign a priority level to each task.

• Assign a due date for any or all of your To Do List items. 

• Assign To Do List items to categories so that you can 
organize and view them in logical groups. For more 
information, see "Categorizing records" on page 84.

• Sort your To Do List items either by due date, priority level, 
or category.

• Attach notes to individual To Do List items for a description 
or clarification of the task. For more information, see 
"Attaching notes" on page 91.

To open the To Do List:

1. Make sure you’re in PDA mode (see page 15). Then, if necessary, 
press the Back button to display the Applications Launcher. 

2. Tap the To Do List icon.

To Do List opens to display the category of items you last viewed.

Creating To Do List items
A To Do List item is a reminder of some task that you have to 
complete. A record in the To Do List is called an item.

To create a To Do List item:

1. Tap the To Do List icon to display the To Do List.
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2. Tap New.

3. Enter the text of the To Do List item. The text can be longer than 
one line.

TIP: You can add a name, address, and phone number to a To 
Do List item using the Phone Lookup option. For more 
information, see "Using Phone Lookup" on page 88.

4. Tap anywhere onscreen to deselect the To Do List item.

TIP: If no To Do List item is currently selected, writing in the text 
input area automatically creates a new item.

Setting To Do List priorities

You can set priorities for tasks in your To Do List according to their 
importance or urgency. Items appear by priority and due date at the 
top of the To Do List by default, with 1 the highest priority. 
Changing an item’s priority may move its position in the list. 

New To Do List items automatically have a priority of 1. If you 
select another item first, before creating a new item, the item you 
create appears beneath the selected item with the same priority as 
the selected item. 

Tap New

New To
Do item
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To set the priority of a To Do List item:

1. Tap the Priority number on the left side of the To Do List item.

Show To Do List screen and priority numbers.

2. Tap the Priority number that you want to set, with 1 the most 
important and 5 the least important. 

Checking off To Do List items

You can check off a To Do List item to indicate that you’ve 
completed it. Tap the box next to the item to check it off the list. You 
can also use Rocker Up and Down to highlight a To Do list item, 
then press Rocker Enter to check or uncheck it. 

To make checked-off items disappear:

You can have completed items remain onscreen, or clear them from 
view.

1. In the To Do List, tap the tab in the upper-left corner to display the 
menu bar. 

Tap to
select

priority

Tap here

Completed To 
Do List item



Using the To Do List

Wrist PDA User Guide 65

2. Tap the Options menu, then tap Show. 

3. Check or uncheck Show Completed Items. If you clear this 
setting, your To Do items disappear from the list when you 
complete (check) them. 

NOTE: Items that no longer appear on the list because Show 
Completed Items is turned off have not been deleted. They are 
still in the memory of your watch. You must purge completed 
items to remove them from memory.

Changing priorities and due dates
You can change the To Do List to display the due date assigned to an 
item, change its priority, and assign a category to the task with the 
To Do Item Details dialog box. 

You can then sort To Do List items by priority, due date, or category.

To change the priority and due date of a To Do List item:

1. In the To Do List, tap the item that you want to change.

2. Tap Details.

3. In the Details dialog box, tap No Date to open the Due Date pick 
list.

4. Tap the date that you want to assign the item. Options are Today, 
Tomorrow, One Week from the current date, No Date to remove 
the due date from the item, or Choose Date to display the date 
selector and select a date. 

5. Tap Private to hide this item when Security is turned on.

For more information, see "Making records private" on page 89.

6. Tap OK.

Tap here.
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To sort To Do items:

1. In the To Do List, tap the tab in the upper-left corner to display the 
menu bar. 

2. Tap the Options menu, then tap Show. 

3. In the To Do Preferences screen, tap Sort By, and then select an 
option from the pick list:

Tap Priority, Due Date to sort items by priority first, and then due 
date. Tap Due Date, Priority to reverse that order.

Tap Category, Priority to sort items by category first, and then 
priority. Tap Priority, Category to reverse that order.

4. Tap OK.

Displaying completed and due items
You can have the To Do List display completed items and their 
completion dates, as well as due items and their due dates. 

To display completed and due items in the To Do List:

1. In the To Do List, tap the tab in the upper-left corner to display the 
menu bar. 

2. Tap the Options menu, then tap Show. 

3. In the To Do Preferences dialog box, choose from the following 
settings:

• Tap Show Completed Items to display your completed items 
in the To Do List. If this setting is turned off, completed To 
Do items disappear from the list, but are kept in the memory 
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of your watch. You must purge completed items to remove 
them from memory.

• Tap Show Only Due Items to show only the items that are 
currently due, past due, or have no due date specified. When 
this setting is active, items that are not yet due do not appear 
in the list until their due date.

4. Tap Next to display these additional options:

• Tap Record Completion Date to replace the due date with the 
actual date when you complete (check) the item. If you do 
not assign a due date to an item, the completion date still 
records when you complete the item. 

• Tap Show Due Dates to display the due dates for items in the 
To Do List and to display an exclamation mark next to items 
that remain incomplete after the due date passes. 

5. Tap OK.
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Using the Address Book
The Address Book lets you keep names, addresses, telephone 
numbers, and other information about your personal or business 
contacts.

Use the Address Book to: 

• Quickly enter, look up, or duplicate names, addresses, phone 
numbers, and other information.

• Enter up to five phone numbers (home, work, fax, car, and so 
on) or e-mail addresses for each name.

• Define which phone number appears in the Address List for 
each Address Book entry. 

• Attach a note to each Address Book entry, in which you can 
enter additional information about the entry.

• Assign Address Book entries to categories so that you can 
organize and view them in logical groups.

To open the Address Book: 

1. Make sure you’re in PDA mode (see page 15). Then, if necessary, 
press the Back button to display the Applications Launcher. 

2. Tap the Address icon.

The Address Book opens and displays the list of your records.

Adding and using Address Book entries
The Address Book application stores name and address information 
about people or businesses.

Creating an Address Book entry

A record in Address Book is called an entry. You can create entries 
on your watch, or you can use Palm Desktop software to create 
entries on your computer and then download them to your watch 
with your next HotSync operation.

Palm Desktop software also has data import capabilities that let you 
load database files into the Address Book on your watch. 

See "Importing data" on page 119 and Palm Desktop online Help for 
more information.
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To create a new Address Book entry:

1. Tap the Address icon to display the Address Book.

2. Tap New.

3. Enter the last name of the person you want to add to your Address 
Book. 

4. Tap the First Name field to move to it. 

5. You can move to any field by tapping it directly.

6. Enter the individual’s first name in the First Name field.

7. If you want to be able to sort the Address Book by company name, 
enter the information you want in the Company field. 

8. Enter any other information that you want to include in the entry.

9. Tap the scroll arrows (or use the watch buttons) to move to the 
next page of information.

10. To attach a note to an entry, tap Note. Enter the information you 
want in the text input area, and then tap Done.

Tap New.

Cursor 
at Last name
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11. When you have finished entering information, tap Done.

TIP: To create an entry that always appears at the top of the 
Address List, begin the Last name or Company field with a 
symbol, as in *If Found Call.* This entry can contain contact 
information in case you lose your watch.

To view details of an address entry:

1. Tap the address entry.

The entry appears in Address view.

2. Tap Done when you have finished viewing the entry.

Duplicating an entry

You can duplicate existing entries, which can be helpful when you 
want to enter multiple people from a single organization. When you 
duplicate an entry, the word Copy appears next to the name in the 
First Name field. 

To duplicate an entry:

1. From the Address Book, tap a name you want to duplicate.

2. Tap the tab at the top-left corner of the screen to display the menu 
bar.

Make sure Record is selected, then tap Duplicate Address. 

3. Edit the record as necessary. 

Tap Done
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Selecting specific address details

You can select the specific information that an Address Book entry 
displays. Any changes you make apply only to the current entry. 

To select a different address detail:

1. Tap the entry that you want to change in the Address list. 

2. Tap Edit.

3. Tap the pick list next to the label you want to change.

4. Select a new label.

Editing Address Book entries

You can change the type of information that appears in the Address 
List screen, categorize an entry, and hide an entry for security 
reasons. You can also delete entries. 

To edit an Address Book entry:

1. Tap the entry that you want to change in the Address list.

2. Tap Edit.

3. Tap Details.

4. In the Address Entry Details dialog box, select any of the 
following settings:

Tap 
triangle
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• Tap Show in List, and in the pick list tap which type of phone 
or other information you want to appear in the Address List 
screen. Options are Work, Home, Fax, Other, and E-mail. 

• Tap Category, and then tap a category in the pick list that 
you want to assign to the entry. 

• Tap Private to hide the entry when Security is turned on.

5. To attach a note to an entry, tap Note, enter information in the text 
input area, and tap OK.

6. To delete an entry, tap Delete.

7. Tap OK.

Changing the Address Book display
You can change how Address Book lists are sorted and you can add 
custom fields for entering additional information, using 
preferences. You can also have the Address Book display the last 
category you selected each time you return to the application.

To change how lists are sorted:

1. Tap the tab in the upper-left corner of the screen to display the 
menu bar.

2. Tap Options, and then tap Preferences.

3. Choose an option to sort Address Book lists from the List By pick 
list:

• Tap Last Name, First Name to sort alphabetically by an 
individual’s last name and then first name.

• Tap Company, Last Name to sort alphabetically by the 
company name, and then an individual’s last name.

4. Tap OK.
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To add custom fields at the end of Address Edit screens:

1. Tap the tab in the top-left corner of the screen to display the menu 
bar.

2. Tap Options, and then tap Rename Custom 
Fields.

3. In the text input area, rename the fields to 
identify the information you’ll enter in 
them. The names you give the custom fields 
appear in all entries, at the end of the 
Address Edit screen. 

4. Tap OK in the Rename Custom Fields 
dialog box.

5. Tap Done.

To control the Address Book display on returning to the 
application:

1. Tap the tab in the upper-left corner of the screen to display the 
menu bar.

2. Tap Options, and then tap Preferences.

3. In the Address Book Preferences dialog box, select an option:

• To have the Address Book redisplay the last category you 
selected on returning to the application, tap the Remember 
Last Category check box to select it.

• To have the Address Book display the All category on 
returning to the application, clear the Remember Last 
Category check box.

4. Tap OK.
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Using the Memo Pad
The Memo Pad provides a place to take notes that are not associated 
with records in the Date Book, Address Book, or To Do List. You can 
also:

• Assign memos to categories so that you can organize and 
view them in logical groups.

• Write down phone numbers and other types of information. 
Later, you can copy and paste this information into other 
applications. 

To open the Memo Pad:

1. Make sure you’re in PDA mode (see page 15). Then, if necessary, 
press the Back button to display the Applications Launcher. 

2. Tap the Memo Pad icon.

The Memo Pad opens to display the last Memo Pad screen that you 
viewed.

Creating memos
A record in the Memo Pad is called a memo. A memo can contain up 
to 4,000 characters. The number of memos you can store is limited 
only by the memory available on your watch.

When you create a new memo, you can add information to it from 
the Address Book application, such as a phone number or address, 
using the Phone Lookup option. See "Using Phone Lookup" on page 
88.

To create a new memo:

1. Tap the Memo Pad icon to display the Memo List.

2. Tap New.
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TIP: You can also create a new memo by beginning to write in 
the text input area in the Memo List screen. The first letter is 
automatically capitalized and begins your new memo. 

3. Enter the text you want to appear in the memo. Use the carriage 
return stroke (new line stroke) to move down to new lines in the 
memo.

TIP: You form the carriage return stroke by drawing a diagonal 
line toward the lower-left corner of the screen.

4. Tap Done. 

You can categorize memos and sort them by categories. See 
"Categorizing records" on page 84 and "Sorting records" on page 88 
for more information.

Reviewing memos
The Memo List displays the first line of a memo. This makes it easy 
to locate and review your memos. You can easily sort memos in the 
Memo List or move through memos using Memo options.

To review a memo:

1. In the Memo List, use Rocker Up and Down to change the 
selection highlight, then press Rocker Enter to open the selected 
item. You can also tap the memo if you are using the stylus. If 
there are more memos than fit on the screen, use Page Up and 
Down to view additional screens. 

Tap New.
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2. Review or edit the text in the memo. 

3. Tap Done.

TIP: When you’re looking at the text of a memo, you can easily 
jump to other memos for review. Use the Up and Down buttons 
on the watch to skip to other memos.

To change the order in which memos appear in the Memo List:

1. Tap the tab in the upper-left corner of the screen to display the 
menu bar.

2. Tap Options.

3. Tap Preferences, and choose one of the following options:

• Tap Manual to sort new memos in the sequence in which you 
create them.

• Tap Alphabetical to sort new and existing memos in 
numerical and then alphabetical sequence. 

4. Tap OK.

Tap a memo 
to review its 
contents
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Using the Calculator
The Calculator lets you perform basic arithmetic, such as addition, 
subtraction, multiplication, and division. 

To open the Calculator:

1. Make sure you’re in PDA mode (see page 15). Then, if necessary, 
press the Back button to display the Applications Launcher. 

2. Tap the Calc icon.

The calculator displays on the screen.

Using the Calculator buttons
The Calculator includes several buttons to help you perform 
calculations.

• The CE button clears the last number you entered. 
Use this button if you make a mistake while entering a 
number in the middle of a calculation. This button enables 
you to re-enter the number without starting the calculation 
over.

• The C button clears the entire calculation and enables 
you to begin a fresh calculation.

• The Plus/Minus button toggles the current number 
between a negative and positive value. If you want to enter a 
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negative number, enter the number first and then press the 
+/- button.

• The M+ button places the current number in memory. 
Each new number you enter with the M+ button is added to 
the total stored in memory. The number that you add can be 
either a calculated value or any number you enter by 
pressing the number buttons. Pressing this button has no 
effect on the current calculation (or series of calculations); it 
merely places the value into memory until it is recalled.

• The MR button recalls the stored value from memory 
and inserts it in the current calculation.

• The MC button clears any value that is stored in the 
Calculator memory.
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5
Performing Common 
Tasks
The tasks described in this section use the term records to refer to an 
individual item in any of the basic applications, for example, a 
single Date Book event, Address Book entry, To Do List item, or 
Memo Pad memo.

Creating records
You can use the following procedure to create a new record in the 
Date Book, Address Book, To Do List, or Memo Pad.

To create a record:

1. Select the application in which you want to create a record.

2. Tap New. (For the Date Book only, select start and end times for 
your appointment and tap OK.)

3. Enter text for the record.

NOTE: The Wrist PDA automatically capitalizes the first letter of 
each field. 

4. As an option, tap Details to select attributes for the record.

5. In the Address Book and Memo Pad only, tap Done.

Your watch saves the new record automatically.
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Editing records
After you create a record, you can change, delete, or add new 
information at any time. When the screen is in edit mode, a blinking 
cursor appears within the information, and the information appears 
on a dotted gray line called an edit line.

You can enter text in any of the ways described in Chapter 2, 
“Entering Data in your Wrist PDA™ Watch.”

Selecting Text
Select the text you want to edit using one of the following 
techniques:

• Double-tap on a word in a field to select the word.

• Triple-tap on any word on a line to select the entire line.

• To select several characters, words, or lines, tap and hold 
with the stylus until you hear a beep. Then drag the stylus 
left or right across the text you want to highlight, or drag up 
or down to select multiple lines.

Edit line 

Cursor
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Using the Edit menu
The Edit menu is available from any screen where you enter or edit 
text. As a general rule, the Edit menu commands affect selected text. 
You can display the Edit menu by tapping the tab at the upper-left 
corner of the screen, or by writing a ShortCut. 

To use the Edit menu: 

1. Do one of the following to display the Edit menu: 

• Tap the tab at the upper-left corner of the screen; then tap the 
Edit menu to display the commands in the menu. 

• In the text input area, drag a diagonal line from the lower left 
to upper right to display the Command toolbar. To select a 
command, either tap the icon representing a command on the 
Command toolbar, or draw the ShortCut in the text area of 
your screen.

2. Choose from the following commands, depending on the 
application you’re using: 

• Undo reverses the last action taken. 

• Cut removes a selection from its current location to memory. 
You can then paste the text into another area of the current 
application or into a different application.

• Copy copies a selection and moves it to memory. You can 
paste the selection into another area of the current 
application or into a different application.

• Paste inserts a selection from memory into an area you select. 
Paste produces no result if you have not used the Cut or 
Copy commands. 

• Select All selects all the text in the current record or screen. 

• Keyboard opens the onscreen keyboard. Tap Done to close 
the keyboard. 

• Graffiti2 Help opens the Jot character stroke screen.
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Deleting records
You can delete records in any of the basic applications. 

To delete a record in any of the basic applications:

1. Select the record you want to affect.

2. Do one of the following: 

• Tap the tab at the upper-left corner of the screen, open the 
Record menu, and then select the desired Delete command. 

The Delete command differs depending on the application 
you’re using, for example, Delete Event appears in the 
Record menu while you’re in the Date Book, and Delete Item 
appears when you’re using the To Do List.

• In the Details dialog box of the application, tap Delete, and 
then tap OK.

• Delete the text of the record.

NOTE: In the Date Book, deleting the text of a repeating event 
deletes all instances of the event. 

• In the text input area, drag a diagonal line from the lower left 
to upper right to display the Command toolbar; then tap the 
Delete icon or draw a ‘D’ in the text area.

A confirmation dialog box appears. 

3. To archive a copy of the deleted file on your PC, select the Save 
Archive option. If you choose the archive option, the record is 
transferred to the archive file on your PC the next time you 
perform a HotSync operation.

4. Tap OK to delete the record. 

Delete icon
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Purging records
Over time, as you use Date Book and To Do List, you may 
accumulate records that are no longer useful. For example, events 
that occurred months ago remain in the Date Book, and completed 
To Do List items remain in the list.

Outdated records take up memory on your watch, so it’s a good 
idea to remove them by using Purge. If you think Date Book or To 
Do List records might prove useful later, you can purge them from 
your watch and save them in an archive file. 

Purging is not available in Address Book or Memo Pad; delete 
records from these applications manually. 

To purge records:

1. Open the application from which you want to purge records. 

2. Tap the tab at the upper-left corner of the screen, open the Record 
menu, and select Purge. 

3. Choose from the following options:

• For the Date Book, select the Delete Events Older Than pick 
list and select an option—1 week, 2 weeks, 3 weeks or 1 
month.

• For the Date Book or To Do list, select Save Archive Copy on 
PC to save a copy of purged records in an archive file on your 
desktop. Selecting this option transfers purged records to an 
archive file the next time you perform a HotSync operation. 
Tap OK.
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Categorizing records
You can categorize records in the Address Book, To Do List, and 
Memo Pad applications for easy retrieval. (The Date Book does not 
have categories.) When you create a record, it is automatically 
assigned to the currently displayed category. For example, if the All 
category is displayed, the record is assigned to the Unfiled category. 
A record can remain unfiled or it can be assigned to a category at 
any time. 

In addition to the All and Unfiled categories, each application has a 
default set of categories: 

• The Address Book includes a Business, Personal, and 
QuickList category.

• The Memo Pad and To Do List include a Business and 
Personal category.

You can rename or delete the default categories, and you can create 
new categories. Each application can have up to 15 categories.

To move a record into a category:

1. Select the record you want to categorize.

2. Tap Details. (From the Address View screen, tap Edit first.)

3. In the Details dialog box, tap the Category pick list, select the 
desired category, and then tap OK. 

To display a category of records:

1. Open an application: the Address Book, the To Do List, or the 
Memo Pad. 

2. Tap the pick list in the upper right corner of the screen; then tap 
the category you want to display. 
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To add or edit application categories:

1. In the Address Book, To Do List, or Memo Pad application, 
choose from the following options:

• Tap the pick list in the upper right corner of the screen, and 
tap Edit Categories. 

• In the Address Book, select a record and tap Edit; then tap 
Details. In the Category pick list, tap Edit Categories.

• In the Memo Pad and To Do List, select a record from the list, 
and tap Details. In the Category pick list, tap Edit Categories.

2. Select any of the following options:

• To create a new category, tap New, and enter a new name in 
the text input area. Tap OK. 

Tap pick list Select a category

Edit Categories
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• To rename a category, tap it in the list to select it. Tap 
Rename, enter a new name in the text input area, and Tap 
OK.

• To delete a category, tap it in the list to select it. Tap Delete.

3. Tap OK.

To rename a category:

1. Tap the pick list in the upper right corner of the screen; then tap 
Edit Categories. 

2. Select the category you want to rename; then tap Rename.

3. Enter the new name for the category, and tap OK.

4. Tap OK to exit the Edit Categories dialog box. 

TIP: You can move records from multiple categories into a 
single category by individually renaming all categories with a 
single category name. 
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Finding records 
Your watch lets you find information in several ways: 

• In the Applications Launcher, you can enter the first letter of 
the application you are searching for. This highlights the first 
application that starts with that letter.

• In the Address Book, you can use the Look Up option to 
enter the first letters of a name to scroll immediately to that 
name.

• In the Date Book, the To Do List, and the Memo Pad, you can 
use Phone Lookup to display the Address List screen and 
add the information from this list to a record.

Finding Address Book records
You can look up Address Book records using the Scroll/Enter 
button on the left side of the watch or by typing the first few letters 
of a name in the Look Up option at the bottom of the address screen. 

To look up an Address Book record: 

1. Do one of the following:

• From the Address screen, enter the first few letters of the 
name you want to locate. 

• Use the Scroll/Enter button on the left side of the watch to 
scroll one record at a time. Holding down the scroll button 
accelerates scrolling. You can also use the Up and Down 
buttons to move one screen at a time.

Look Up option
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Using Phone Lookup 
The Phone Lookup option lets you add a telephone number from 
the Address list to an entry in another application. For example, you 
can add your dentist’s telephone number to your dental 
appointment date in the Date Book. 

To use Phone Lookup:

1. Display the record in which you want to insert a phone number. 
The record can be in the Date Book, To Do List, or Memo Pad.

2. Do one of the following: 

• Tap the tab at the upper-left corner of the screen; then tap 
Options and tap Phone Lookup. 

• In the text input area, drag a diagonal line from the lower left 
to upper right to display the Command toolbar. In the text 
area, write an L, the ShortCut for the Phone Lookup 
command. 

3. Select a record or write the first few letters of the name you want 
to add. Tap Add to add the information to the record.

NOTE: You can also search based on selected text. Drag to 
highlight the text, then follow step 2 above. When the search is 
complete, the name and phone number of the candidate will 
replace the selected text.

Sorting records
You can sort lists of records in various ways, depending on the 
application. Sorting is available in applications that display lists—in 
the Address Book, To Do List, and Memo Pad.

To sort records in the To Do List:

1. Open the application to display the list screen.

2. Tap Show.

3. Tap the Sort By pick list, and select an option.

4. Tap OK.
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To sort records in the Address Book and Memo Pad:

1. Open the application to display the list screen.

2. Do one of the following:

• Tap the tab at the upper-left corner of the screen; then tap 
Preferences in the Options menu. 

• In the text input area, drag a diagonal line from the lower left 
to upper right to display the Command toolbar. In the text 
area, write an R, the ShortCut for the Preferences command. 

3. In the Preferences dialog box, tap the option you want; then tap 
OK to sort the list. 

To sort the Memo List manually:

Tap and drag a memo to a new location in the list.

NOTE: To display the list of your memos on your computer as 
you arranged them manually on your watch, open Memo Pad in 
the Palm Desktop software, click List By, and select Order on 
Handheld.

Making records private
In all the basic applications, you can make individual records 
private. Private records can be either masked or hidden. Private 
records remain visible and accessible until you select a security 
setting to Hide records. Private record names are covered with a 
gray bar when the security setting is set to Mask records.

If you have assigned a password to your device, you must enter it 
before private records are displayed. See "Assigning security 
options" on page 102 for more information.

To make a record private:

1. In your application, do one of the following:

• Create a new record and tap Edit, and then tap Details.

• Select an existing record, and tap Details.

2. Tap the Private check box. Tap OK.
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3. At the alert in the Private Records dialog box, tap OK.

To hide private records:

1. Do one of the following:

• From the Applications Launcher, tap the Security icon.

• From within an application, tap the tab at the upper-left 
corner of the screen; then tap Security in the Options menu. 

2. In the Change Security dialog box, in the Current Privacy pick 
list, tap Hide Records; then tap OK.

To display private records:

1. Do one of the following:

• From the Applications Launcher, tap the Security icon.

• From within an application, tap the tab at the upper-left 
corner of the screen; then tap Security in the Options menu. 

2. From the Current Privacy pick list, tap Show Records; then tap 
OK.

3. If you have assigned a password, you must enter the password 
before the hidden records are displayed. 

4. Enter your password, and then tap Show.
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Attaching notes
You can attach notes to records in all the basic applications except 
the Memo Pad. A note can be up to several thousand characters 
long. 

To attach a note to a record:

1. Display the entry to which you want to add a note. 

2. In Address Book only, tap Edit.

3. Tap Details. 

4. Tap Note; then enter the desired note. 

5. Tap Done.

A note icon appears to the right of any item containing a note. 

To review or edit a note:

Tap the note icon.

To delete a note:

1. Tap the note icon.

2. Tap Delete; then tap Yes to delete the note. 

Note icon
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Choosing fonts
You can change the font style in all basic applications. You can 
choose a different font style for each application.

To change the font style:

1. Open an application.

2. Do one of the following: 

• Tap the tab at the upper-left corner of the screen; then tap 
Font in the Options menu. 

• In the text input area, drag a diagonal line from the lower left 
to upper right to display the Command toolbar. In the text 
area, write an F, the ShortCut for the Font command. 

3. Use Rocker Up and Down to highlight the desired font and then 
press Rocker Enter to select it. Or use the stylus to tap the font, 
then tap OK.

Small font Large font

Bold font

Select font
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Getting information about an application
You can get information about any application by displaying its 
About box. The About box displays the name and version number 
of the application. 

To display the About box:

1. Tap the tab in the upper-left corner of the application. 

2. In the Options menu, tap About. 

The text following the About command differs based on your 
location. For example, if you’re in the Date Book, the command is 
About Date Book; if you are in the Address Book, the command is 
About Address Book. 
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6
Customizing Your 
Watch

Customizing your watch
You can customize your watch in the following ways:

• Input the current date and time 

• Choose the delay period before the watch automatically 
displays the time

• Select a watch application and watch face

• Change how long you have to press and hold a button to 
activate the EL backlight or cause the watch to enter PDA 
mode 

• Display date, time, and numbers in various international 
formats

• Allow your watch to automatically receive any data beamed 
to it

• Set up security options

• Display owner information 
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Setting the date, time, and time zone
The Preferences screen lets you set the 
date, time, and time zone for your watch.

To set the date:

1. Tap the Prefs icon.

2. From the pick list in the upper right corner, tap Date & Time.

3. On the Date & Time screen, tap the Set Date box.

4. Use Page Up and Down to select the month, then use Rocker Up 
and Down to select the day. 

5. When the current day is selected, press Rocker Enter. 

The screen closes and the dates you selected are displayed in the Set 
Date box.

To set the time:

1. Tap the Prefs icon.

2. From the pick list in the upper right corner, tap Date & Time.

3. On the Date & Time screen, tap the Set Time box

4. Use Rocker Up and Down to adjust the hour. When the hour 
passes 12 o’clock, AM and PM will switch automatically. Use Page 
Up and Down to adjust the minutes. 

5. When the correct time is displayed, press Rocker Enter to return to 
the Date & Time screen.

NOTE: To display time based on a 24-hour clock, change the 
time format. See "Formatting the date, time, and numbers" on 
page 100.
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To set the time zone:

1. Tap the Prefs icon.

2. From the pick list in the upper right corner, tap Date & Time.

3. On the Preferences screen, tap the Set Time Zone box.

4. Use Rocker Up and Down to change the highlighted time zone. 
Use the Page buttons to move by screen. Highlight the time zone 
you want to use and press Rocker Enter to select it. 

TIP: Choose the time zone from the list that corresponds to 
where you are. When you travel, use this dialog to change time 
zones. If you’re not sure what time zone you are in, find out what 
time it is, and select the time zone which shows the current new 
time.
Do not use the time zone dialog box to switch between daylight 
savings time and standard time. Use the Daylight Savings pick 
list.

The screen closes and the dates you selected are displayed in the 
Date & Time screen.

To set daylight savings time:

1. Tap the Prefs icon, then select Date & Time from the pick list in 
the upper right corner of the screen.

2. Tap on the Daylight Saving pick list to toggle this feature on or 
off.
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Selecting Wrist PDA preferences
The Wrist PDA Preferences screen lets you choose the behavior of 
the watch when it goes into sleep mode (auto-off), select the watch 
application used to display the time, and lock the watch face. It also 
lets you select how long you have to press the Rocker switch to exit 
sleep mode and return to PDA mode, and how long to press the 
Back button to turn on the EL backlight. 

To access the Wrist PDA Preferences screen:

1. Tap the Prefs icon.

2. Select WristPDA from the pick list in the upper-right corner of the 
screen.

You see this screen displayed:

Choosing the auto-off display and watch application 
preferences:

• To control the behavior of the watch when it goes into sleep 
mode (auto-off), select one of the Mode options: Current 
leaves the current PDA application on the screen, Watch 
displays the time using the selected watch application, and 
Off displays a blank screen.

• If Mode is set to Watch, you can select which watch 
application you want to use to display the time. Tap Watch 
App to display a list of the currently installed Watch 
applications, then select one of the available options.

• To prevent the currently selected watch face from being 
accidentally changed by pressing Rocker Up or Down, tap 
the Lock Face checkbox.
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Changing the key timeouts:

• Tap the Enter PDA pick list to choose how long you have to 
press the Rocker switch to exit sleep mode and return to PDA 
mode.

• Tap the Back Backlight pick list to choose how long you 
have to press the Back button to turn on the EL backlight.

Setting the auto-off delay time
Your Wrist PDA watch goes into sleep mode (auto-off) after a brief 
period of inactivity (when you don’t use the stylus or press any 
buttons). If you’ve selected Watch as the auto-off display mode (see 
page 98), the time automatically displays when the watch goes into 
sleep mode. If you find that this happens before you finish 
reviewing the information on the screen, you can increase the time 
delay.

To set the auto-off interval:

1. Tap the Prefs icon. 

2. In the pick list in the upper right corner, tap General.

3. In the General Preferences screen, change the timing by tapping 
the Auto-Off After pick list. Tap an option—30 seconds, 1 minute, 
90 seconds, or 2 minutes.

Choosing a watch face
You can choose a new watch face by using the Watch application. 

1. Press the Back button to display the Applications Launcher. Press 
the button several times until you see the All category displayed 
in the upper-right corner.

2. Tap the Watch application icon. 

3. Press Rocker Up or Down to select your favorite watch face, then 
press Rocker Enter to select it and return to the Applications 
Launcher.

When the watch goes into sleep mode, the watch face you selected 
will display the time.
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You can also change the watch face while the time is displayed in 
sleep mode (but the Lock Face option must be unchecked; see page 
98). Use Rocker Up or Down to view the available watch faces. 
When the one you want to use is displayed, simply stop using the 
Rocker switch. This will be the watch face that displays when the 
watch goes into sleep mode.

Formatting the date, time, and numbers 
The Formats Preferences screen lets you choose a default country for 
your device and also lets you set defaults for times, dates, and 
number formats. When selecting a country and time, date, and 
number formats, keep the following in mind: 

• When you select a country, the time, date, and number 
formats are adjusted, as well as the week’s starting day. For 
example, in Germany, time often is expressed using a 24-
hour clock and the starting day of the week is Monday; in the 
United States, however, time is expressed using a 12-hour 
clock with an AM or PM suffix and the starting day of the 
week is Sunday. You can customize the settings.

• The Time setting defines the format for the time of day, 
which appears in all applications on your watch. 

To choose a country default: 

1. Tap the Prefs icon.

2. In the pick list in the upper right corner, tap Formats.

3. Tap the Preset To pick list to view the available country preset 
options. Press Rocker Up or Down to highlight the desired option, 
then press Rocker Enter to select it.
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To change the formatting of the time, date, week start, and 
numbers:

1. Tap the Prefs icon.

2. In the pick list in the upper right corner, tap Formats.

3. In the Formats Preferences screen, tap the Time pick list and select 
a format, where H is hour and M is minute. 

4. Tap the Date pick list and select a format, where D is day, M is 
month, and Y is year.

5. Tap the Week starts pick list, and select whether you want the 
first day of the week to be Sunday or Monday. 

This setting controls the Day, Week, Month, and Agenda views in 
Date Book and all other aspects of your watch that display a 
calendar.

6. Tap the Numbers pick list, and select formats for the decimal 
point and thousands separator.

Selecting sound settings
You can control the sound for system alerts, alarms, and games 
using the General Preferences screen.

To turn on or off the sounds:

1. Tap the Prefs icon. 

2. In the pick list in the upper right corner, tap General.

3. Tap the System, Alarm, or Game Sound pick list, and select the 
sound option—On or Off.

NOTE: The Game Sound setting typically works only with newer 
games that are programmed to respond to it.

Turning Beam Receive on and off
Beaming is discussed starting on page 107. To turn beaming on or 
off, see page 110.
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Assigning security options
Your watch includes a Security application that lets you set options 
to protect entries from unauthorized users in a variety of ways:

The Security application lets you: 

• Mask or hide entries you have defined as private. The Mask 
option displays a gray bar over private records, and the Hide 
option completely removes (hides) private records. 

• Assign a password to viewing options to enhance security. 
Assigning a password requires you to enter a password 
before private entries can be viewed; not assigning a 
password lets you view private entries when you Show 
Records from the Security dialog box. 

• Lock your Wrist PDA so that a password must be entered 
before you can use the device again. 

• Hide records that you have defined as private, with or 
without a password. Without a password, private records are 
hidden until you set the Security application to display them; 
with a password, you must enter the password to view the 
private entries.

Masking and hiding records
You can mask or hide private records. When you mask private 
records, a visual placeholder appears where the record would 
normally be displayed; when you hide records, they are not visible 
anywhere in the list. 

To mask private records:

1. Make sure that the record or records you want to mask are defined 
as private. To make a record private, select the record, tap Edit, tap 
Details, and then tap the Private option. 

2. From the Applications Launcher, tap Security.
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3. From the Current Privacy pick list, tap Mask Records. 

4. Open one of the basic applications and view a record. Records 
marked as private are masked with a gray bar. 

To hide private records:

1. Make sure that the record or records you want to hide are defined 
as private. To make a record private, select the record, tap Edit, tap 
Details, and then tap the Private option. 

2. From the Applications Launcher, tap Security.

3. From the Current Privacy pick list, tap Hide Records.

4. When you return to the Address Book, records marked as private 
are not included in the display of names.

Note that you can mask or hide records without assigning a 
password, or you can assign a password if you want records to 
remain masked or hidden until a password is entered. 

Assigning and editing passwords
You can assign a password to protect your private records and to 
lock your watch.

Once you define a password, you can change or delete it at any 
time. You must enter the current password before you can change or 
delete it. 

To assign, change, or delete a password:

1. In the Applications Launcher, tap the Security icon. 

2. Tap the Password box. 
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3. Enter a password—either the one you want to assign or your 
current password if you want to change or delete it—and tap OK

4. Choose from the following options:

• To assign a password, enter the password again to verify it, 
and tap OK. 

• To change your password, enter a new password and tap 
OK.

• To delete your password, enter your current password. Tap 
OK, and then tap Delete.

Locking your watch
You can lock your watch with a password to protect information. 
When it’s locked, you see a System Lockout screen displaying the 
name of the owner (see “Displaying owner information” below). 
You must then enter your password to continue using the watch and 
gain access to the information on it.

If you forget the password, you must perform a hard reset to resume 
using your watch. Performing a hard reset deletes all the records in 
your watch; however, you can restore all synchronized data at the 
next HotSync operation. See page 131 for more information.

To lock your watch with a password:

1. Assign a password, as described in “Assigning and editing 
passwords” above. 

A password is required before using the Lock & Turn Off option.

2. Tap Lock & Turn Off. The System Lockout dialog box appears. 

3. Tap Off & Lock. You device is turned off and is locked. 

To unlock your watch:

1. Enter your password in the System Lockout screen. 

2. Tap OK. 
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Displaying owner information
Owner Preferences lets you record a name, company name, phone 
number, or any other information you want to include on your 
watch. If you use the Security application to lock your watch with a 
password, information that you entered in Owner Preferences 
appears on the screen. 

To change owner preferences on your watch: 

1. From the Applications Launcher, tap the Prefs icon. 

2. Tap Owner from the pick list in the upper right corner.

3. On the Owner Preferences screen, enter the text you want to 
associate with your watch. If you enter more text than can fit on 
one screen, a scroll bar appears at the right side of the screen. 

NOTE: If you have assigned a password to your device using 
the Security application, you must unlock the Owner Preferences 
screen to change the information on it. 

To unlock the Owner Preferences screen: 

1. Display the Owner Preferences screen.

2. Tap Unlock. The Unlock Message dialog box appears. 

3. Enter your current password (the one you entered in the Security 
application); then tap OK. 

4. Edit the Owner Preferences text as desired. 
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7
Beaming Information
Your Wrist PDA watch is equipped with an IR (infrared) port that 
you can use to beam information to another Palm-style device that’s 
close by and also has an IR port. The IR port is located at the top of 
the watch, behind the small dark shield. 

You can beam the following information between Fossil connected 
organizers:

• The record currently displayed in Date Book, Address Book, 
To Do List, or Memo Pad.

• All records of the category currently displayed in the 
Address Book, To Do List, or Memo Pad applications.

• A special Address Book record that you designate as your 
business card, containing information you want to exchange 
with business contacts.

• An application installed in RAM memory.

For best results, place the beaming devices approximately 1 to 18 
inches apart, making sure the path between the two devices is clear 
of obstacles. The beaming distances for some brands of devices may 
be different. 

Beaming a business card

Creating a business card for beaming:
Before you can beam a business card, you have to set up an Address 
Book record as a business card. The record should contain any 
information about yourself that you want to give out. 
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To create a business card:

1. Open the Address Book application.

2. In the Address List, create a new entry or select an entry that 
contains the information you want on your business card. See 
"Adding and using Address Book entries" on page 68 for more 
information.

3. In Address view, tap the tab in the upper-left corner to display the 
menu bar. 

4. Tap the Record menu, then tap Select Business card. 

5. At the prompt, tap Yes.

A business card icon appears next to the Address View tab at the top 
of the screen. 

Beaming a record
To beam a record, business card, or category of records:

1. Locate the record, business card, or category you want to beam.

2. Tap the Menu icon.

3. Tap Record.

4. Choose from the following options:

• Tap Beam to beam an individual item.

• In the Address Book application only, tap Beam Business 
Card.

• Tap Beam Category (for records that are displayed in a 
category).

• Use the Command stroke /B to beam the current entry.

5. When the Beam Status dialog box appears, point the IR port 
directly at the IR port of the receiving device.

When the Beam Status dialog box indicates that the transfer is 
complete, you can resume working on your watch.
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Beaming an application
To beam an application:

1. From the Applications Launcher, tap the tab in the upper-left 
corner to display the menu.

2. From the App menu, tap Beam.

3. Tap the application you want to transfer, and tap Beam.

NOTE: Some applications are copy-protected and cannot be 
beamed, as indicated by a lock icon. 

4. When the Beam Status dialog box appears, point the IR port 
directly at the IR port of the receiving device.

When the Beam Status dialog box indicates that the transfer is 
complete, you can resume working on your watch.

Receiving beamed information
To receive beamed information:

1. If necessary, wake your watch into PDA mode by pressing Rocker 
Enter.

2. Point the IR port directly at the IR port of the transmitting device 
to open the Beam Status dialog box.

3. Tap Yes.

4. Wait for the Beam Status dialog box to indicate that the transfer is 
complete, and then tap OK to display the new entry. 

5. Incoming records are placed in the Unfiled category.
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Turning off beaming
To turn beaming on or off:

1. From the Applications Launcher, select All or System from the 
pick list in the upper right corner of the screen.

2. Tap Preferences.

3. In the pick list in the upper right corner, tap General.

4. In the General Preferences screen, tap the Beam Receive pick list, 
and then tap On or Off to select the option.
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8
Exchanging and 
Updating Data using 
HotSync Operations
HotSync technology lets you synchronize—exchange and update—
data between your Wrist PDA and the Palm Desktop software or 
another personal information manager (PIM) such as Microsoft® 
Outlook®. To synchronize data, you must connect your watch to the 
HotSync Pod attached to your computer, or use infrared 
communication with your computer’s IR port (if it has one). 

The HotSync process automatically synchronizes data between your 
watch and Palm Desktop software. Changes you make on your 
watch or Palm Desktop software appear in both places after a 
HotSync operation. HotSync technology synchronizes only the 
needed portions of files, thus reducing synchronization time. 

Performing a HotSync operation for the first time
The first time you synchronize your data, you must enter user 
information on both the watch and Palm Desktop software. After 
you enter this information and synchronize, the HotSync Manager 
recognizes your watch and doesn’t ask for this information again.
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Performing the first local HotSync operation
The following steps assume that you have already installed the 
Palm Desktop software, as described in the Getting Started booklet. 

To perform a local HotSync operation:

1. Turn the watch over and connect the cable from the HotSync Pod 
to the port on the back of the watch.

2. If the HotSync Manager is not running, start it: On the Windows® 
desktop, click Start, and then choose Programs. Navigate to the 
Palm Desktop software program group and choose HotSync 
Manager. Alternatively, you can start the Palm Desktop software 
which automatically opens the HotSync Manager.

TIP: You can start the HotSync operation by pressing the 
HotSync button on the HotSync Pod. Or follow steps 3 through 5 
below to start the HotSync operation from your watch.

3. Press the Back button on the left side of your 
watch until the System category is displayed as 
shown.

4. Tap the  HotSync icon to open the 
application.

Select System
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5. Once the HotSync application opens, tap the 
HotSync icon as shown. This starts the 

HotSync operation. 

6. If you are performing the HotSync operation 
for the first time, you must enter a user name 
in the New User dialog box and click OK. The 
HotSync Progress dialog box appears and 
synchronization begins. 

Every watch should have a unique name. To prevent loss of a user’s 
records, never try to synchronize more than one watch to the same 
user name.
 

7. Wait for a message on your watch indicating that the process is 
complete.

When the HotSync process is complete, you can disconnect your 
watch from the HotSync Pod.

Selecting HotSync setup options
You can choose when you want HotSync Manager to run. 

To set the HotSync options:

1. Click the HotSync Manager icon in the Windows system tray.

2. Make sure Local USB and Local Serial are selected.

NOTE: The Wrist PDA COM Port Manager automatically 
detects and enables the correct COM port setting. See page 118.

3. Choose Setup. 

Tap here
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4. Click the General tab, and select one of the following options:

• Always Available adds HotSync Manager to the Startup 
folder and constantly monitors the communication port for 
synchronization requests from your watch. With this option, 
the HotSync Manager synchronizes data even when Palm 
Desktop software is not running.

• Available Only When Palm Desktop software Is Running 
starts HotSync Manager and monitors requests automatically 
when you open Palm Desktop software.

• Manual monitors requests only when you select HotSync 
Manager from the Start menu.

If you’re not sure which option to use, keep the default 
setting, Always Available.

5. Click OK.

Customizing HotSync application settings
For each application, you can define a set of options that determines 
how records are handled during synchronization. These options are 
called a “conduit.” By default, a HotSync operation synchronizes all 
files between the watch and Palm Desktop software. 

In general, you should leave the settings to synchronize all files. The 
only reason you might want to change these settings is to overwrite 
data on either your watch or Palm Desktop software, or to avoid 
synchronizing a particular type of file because you don’t use it.

In addition to the conduits for Date Book, Address Book, To Do List, 
and Memo Pad, the Palm Desktop software includes System and 
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Install conduits. The System conduit backs up the system 
information stored on your watch, including ShortCuts. The Install 
conduit installs applications on your watch. 

To customize HotSync application settings:

1. Click the HotSync icon in the Windows system tray (bottom right 
corner of the taskbar).

Tip: You can also click the HotSync command on the Palm Desktop software menu 
bar.

2. From the HotSync Manager menu, choose Custom.

3. Select the appropriate user name from the list.

4. Select an application in the Conduit list. Click Change.

5. Click the direction in which you want to write data, or click Do 
Nothing to skip data transfer for an application.

6. Choose how long the setting will remain in effect:

• To have the setting affect only the next HotSync operation, 
deselect Set As Default. Thereafter, the HotSync Actions 
revert to their default settings. 
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• To use a new setting as the default, select the Set As Default 
option. Thereafter, whatever you selected as the default 
setting is used when you click the Default button in the 
Custom dialog.

7. Click OK.

8. Repeat steps 4 through 7 to change conduit settings for other 
applications.

9. Click Done to activate your settings.

IR HotSync operations
Your Wrist PDA is equipped with an infrared (IR) port that supports 
the IrCOMM implementation of the standards for infrared 
communication established by the Infrared Data Association (IrDA). 
This means that you can beam data to any other device that 
supports the IrCOMM implementation of the IrDA standards. Most 
importantly, you can use the IR port to perform HotSync operations 
even without the HotSync Pod. This is very useful if you travel with 
an infrared-enabled laptop. You simply enable infrared 
communication on your laptop and watch and follow the steps in 
"Performing an IR HotSync operation" on page 118.

Preparing your computer for infrared 
communication
Before you can perform a HotSync operation using the IR port, the 
computer you want to synchronize with must meet the following 
requirements:

• The computer must support the IrCOMM implementation of 
the IrDA standards.

• The computer must have an enabled infrared port built-in, or 
an enabled infrared device attached to the computer.

Desktop computers are likely to require an infrared device attached 
to a physical COM port. Laptops are likely to have a built-in IR port. 
Your computer must also have an installed infrared driver. 

Check if your computer supports infrared communication
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Infrared communication is built into the operating systems for 
Microsoft Windows 98, Macintosh G3, and many later systems. 
Check your computer’s documentation to determine if the 
computer supports infrared communication.

To check the ports used for infrared communication:

1. In the Windows taskbar click Start, choose Settings, and then 
choose Control Panel.

2. Double-click Infrared.

3. Click the Options tab.

4. Select Enable infrared communication.

The COM port displayed in the drop-down box is the port where 
your infrared device is attached. It should be different from any port 
used by the HotSync Manager.

5. Make a note of which port is listed as “Providing application 
support.” You need this information to configure the HotSync 
Manager for infrared communication. This port is the simulated 
port. It is the channel through which the actual infrared 
communication takes place between your computer and your 
watch. 

6. Deselect all other check boxes in the Options tab.

7. Click Apply and OK.

Configuring HotSync Manager for infrared 
communication
Next you need to go to the HotSync Manager and specify the 
simulated port used for infrared communication.

To configure HotSync Manager for infrared communication:

1. Click the HotSync Manager icon in the Windows system tray.

2. Make sure Local is checked on the menu.

3. Choose Setup.

4. Click the Local tab.
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5. In the Serial Port drop-down box, select the COM port that was 
given as the simulated port in the Options tab of the Infrared 
Monitor.

6. Click OK.

The HotSync Manager is now communicating with the simulated 
port defined for infrared communication.

Performing an IR HotSync operation
After you complete the steps to prepare for an IR HotSync operation 
it is easy to perform the actual operation.

To perform an IR HotSync operation:

1. In the Applications Launcher on your watch, tap the HotSync 
icon.

2. Tap Local.

3. Tap the pick list below the HotSync icon and select IR to a PC/
Handheld.

4. Position the IR port of your organizer within a couple of inches of 
the infrared port of your computer.

5. Tap the HotSync icon to start the IR HotSync operation.

You can leave the HotSync application on your watch set to perform 
IR HotSync operations and still use the HotSync Pod. 

Using the Wrist PDA COM Port Manager
When you install the Palm Desktop software for your Wrist PDA, 
the COM Port Manager is installed as well. This application helps 
you by detecting when you insert the HotSync Pod into a USB port 
on your computer and automatically selects the COM port settings 
required for performing HotSync operations. 
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Accessing the COM Port Manager
The COM Port Manager resides in the Windows system tray on the 
right side of the Windows Task Bar. 

To access the COM Port Manager:

1. Click the COM Port Manager icon. You see this screen displayed:

This screen shows you whether the Hot Sync Pod has been detected 
and which COM port it is running on. 

2. If you need to disable the automatic settings, select the checkbox 
for disabling HotSync automatic port configuration. Then click 
Dismiss to minimize the application back to an icon in the system 
tray.

If you need to close the application, right-click the COM Port 
Manager icon and select Exit. 

Importing data
If you have data stored in computer applications such as 
spreadsheets and databases, or if you want to import data from 
another device, you can transfer the data to your Wrist PDA watch 
without having to key it in manually. Save the data in one of the file 
formats listed below, import it into Palm Desktop software, and 
then perform a HotSync operation to transfer the data to your 
watch.

Palm Desktop software can import data in the following file 
formats: 

COM Port Manager icon
HotSync Manager icon
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• Comma delimited (.csv, .txt): Address Book and Memo Pad 
only.

• Tab delimited (.tab, .tsv, .txt): Address Book and Memo Pad 
only.

• CSV (Lotus Organizer 2.x/97 Mapping): Address Book only.

• Date Book archive (.dba).

• Address Book archive (.aba).

• To Do List archive (.tda).

• Memo Pad archive (.mpa).

Archive formats can only be used with Palm Desktop software. Use 
the archive file formats to share information with other people who 
use Palm Powered handhelds or to create a copy of your important 
records.

To import data:

1. Open Palm Desktop software.

2. Click the application into which you want to import data.

3. If you are importing records that contain a field with category 
names, do the following:

• Select All in the Category box.

• Make sure the same categories that appear in the imported 
file also exist in the application. If the categories do not exist, 
the records will be imported into the Unfiled category.

4. Choose File > Import; select the file you want to import, and click 
Open. 

5. To import data into the correct Palm Desktop fields, drag fields in 
the left column so that they are opposite the corresponding 
imported field on the right.

6. To exclude a field from being imported, deselect the field’s check 
box. 

7. Click OK.

8. The imported data is highlighted in the application.

9. To add the imported data to your watch, perform a HotSync 
operation.
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See your Palm Desktop online Help for more information on 
importing and exporting data.

Using File Link
The File Link feature lets you import Address Book and Memo Pad 
information into your watch from a separate external file such as a 
company phone list. HotSync Manager stores the data in a separate 
category on your Palm Desktop software and your watch. You can 
set the File Link feature to check for changes to the external file 
when you perform a HotSync operation. 

With File Link, you can import data stored in any of the following 
formats:

• Comma delimited (.csv).

• Tab delimited (.tsv).

• Memo Pad archive (.mpa).

• Address Book archive (.aba).

• Text (.txt).

For details on setting up a file link, see the Palm Desktop online 
Help.
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9
Installing Palm 
Desktop Software
Follow the instructions in this section if you are already using a 
Palm OS® device with your computer. If the Wrist PDA watch is the 
first Palm OS device you’re going to use with your computer, follow 
the instructions in the Getting Started booklet included with the 
watch.

TIP: For more information on upgrading to the Wrist PDA from 
other Palm OS devices, please visit the website for your brand of 
Wrist PDA:
www.fossil.com/tech/
www.abacuswatches.com

Importing Data From an Existing Palm OS Device
If you are upgrading to a Wrist PDA device from a previous Palm 
OS device, follow these instructions to import your existing data 
before installing the Wrist PDA Palm Desktop Software.

1. Before importing your data, perform a HotSync operation using 
your old Palm OS device to make sure that all of your data is 
backed up. 

2. Open the Palm Folder on your hard drive (usually in Program 
Files\Palm).

3. Create a new folder called "old device" in this directory.
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4. Find the folder that contains the information for your old Palm 
OS device. Its name should be similar to the device's HotSync 
user name.

5. Inside this folder are directories called address, todo, datebook, 
and memopad. Copy these folders and paste them into the "old 
device" directory that you created in step 3

6. Install the Wrist PDA Palm Desktop software by following the 
directions in the next section. Be sure to create a unique user name 
for your new Wrist PDA watch during step7 of the installation 
process.

7. After all of the software is installed, go to your "old device" 
directory and copy the address, todo, datebook, and memopad 
folders (not the backup folder).

8. Paste the folders into the directory that uses your new Wrist PDA 
user name that was created during the software installation.

9. Perform a HotSync operation using your Wrist PDA (see page 
111). The Address Book, To Do List, Memo, and Datebook records 
from your previous handheld will now be copied to your Wrist 
PDA. 

Installing the Wrist PDA Software
Follow these steps to install the required Wrist PDA software:

• Palm Desktop software

• HotSync Manager

• Wrist PDA COM Port Manager

• Wrist PDA HotSync Pod USB Drivers

IMPORTANT: If you already own an existing Palm OS device, 
see “Importing Data From an Existing Palm OS Device”  on page 
123 to import your existing Palm OS data to your Wrist PDA.

1. Exit all running programs. Be sure that Microsoft® Outlook® is 
closed before you begin the installation.
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2. Insert your Wrist PDA CD into your CD ROM drive. The Wrist 
PDA installation menu should open automatically.

3. From the menu, select Wrist PDA Software. This starts the 
installation wizard.

NOTE: If this menu does not open automatically, you may have 
Autorun disabled on your CD ROM drive. To start the installation 
menu manually, open the Run dialog box from the Start Menu. 
Type d:\wristpda.exe, replacing the drive letter "d" with the drive 
letter for your CD ROM drive. 
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4. Wait patiently for the installation program to load. When you see 
this screen, click Next.

5. If you have Microsoft Outlook installed on your computer, you 
will be prompted with the following choice. If you do not have 
Microsoft Outlook installed on your computer, this screen will 
not appear; skip to the step 6.

If you use Outlook to manage Contacts, Tasks, Notes, and 
Calendar information, it is recommended that you choose 
Microsoft Outlook, then click Next.
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IMPORTANT: If you choose Microsoft Outlook, be sure that it is 
not running.

6. You see this screen: 

It is recommended that you choose the Complete setup option, 
then click Next. 

7. You see this screen:

Enter a unique user name for your Wrist PDA. This name will 
identify your Wrist PDA to your synchronization software. Enter 
any name you wish, then click Next.

8. There is now enough information to install the software. Click 
Install to begin the installation.
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9. Wait until all files are copied to your computer and the 
installation process completely finishes.

10. If you are a Windows XP user, you may see the following screen:

Click the Continue Anyway button to continue with the 
installation.

11. If you chose to synchronize your Wrist PDA with Microsoft 
Outlook, the installation program for Chapura PocketMirrorTM 
Standard starts automatically.

NOTE: If you chose not to synchronize your Wrist PDA with 
Microsoft Outlook, skip to step 18

 

12. Click Next to continue.

13. Read the License Agreement for Chapura PocketMirror standard 
and click Yes to continue.



Instal l ing Palm Desktop Software
Installing the Wrist PDA Software

Wrist PDA User Guide 129

14. The next several screens ask you to select folder locations for the 
program and various files. It is recommended that you use the 
default settings and click Next.

15. Choose which Wrist PDA applications you want to synchronize 
with Outlook. Check all of the applications you want to 
synchronize and click Next.

16. Click Next or Finish, as needed, to complete the installation.

17. When you see this screen, installation is complete: 

18. Click Finish to end the Wrist PDA software installation.
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Maintaining Your 
Wrist PDA

Resetting your watch
You may have to perform a reset if your watch no longer responds 
to the stylus or to buttons on the screen. This allows your watch to 
get a fresh start, similar to rebooting a PC. 

Performing a Soft Reset
A soft reset can resolve most problems and does not affect any 
personal data stored on the watch. To perform the reset, gently 
insert the stylus into the hole labeled Reset on the back of the watch. 

Performing a Hard Reset
WARNING: Performing a hard reset erases everything on your watch. All 
personal data, third-party applications, and records are deleted, and the 
watch is returned to its factory default settings. 

If possible, back up all personal data before performing a hard reset. 
Try resolving your problem first using a soft reset (see above). 

To perform a hard reset:

1. Hold in on the Rocker switch and insert the stylus into the hole 
labeled Reset on the back on the watch. 

2. When the Palm PoweredTM logo appears on the display, release 
the Rocker switch. 
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3. When prompted, press the Page Up button to complete the reset, 
or press any other button to cancel the operation. 

Calibrating the screen
If your Wrist PDA does not accurately detect where you place the 
stylus on the screen, you may need to calibrate the screen.

To calibrate your screen:

1. If necessary, press the Back button to display the Applications 
Launcher screen. 

2. In the pick list in the upper right corner of the screen, select All or 
Unfiled. 

3. Tap Digitizer.

4. Follow the on-screen instructions, tapping the screen where 
indicated.

Removing Palm Desktop software 
If you no longer want to use Palm Desktop software, you can 
remove it from your computer. 

To remove Palm Desktop software: 

1. In Windows, from the Start menu, choose Settings > Control 
Panel.

2. Open the Add/Remove Programs icon. 

3. On the Install/Uninstall tab, select Palm Desktop software; then 
click Add/Remove. 



Wrist PDA User Guide 133

11
Frequently Asked 
Questions

General Questions

Where can I find my Wrist PDA’s warranty?
It is located on the Wrist PDA software installation CD.

Is my Wrist PDA waterproof or water-resistant?
No, your Wrist PDA is not water-resistant and you should never let 
it get wet or damp. Water can leak in and damage internal 
components. Always keep your Wrist PDA away from water or 
other liquids, much as you would any other Palm OS device.

Where is the stylus?
The stylus is integrated into the metal wristband or into the band 
keeper for plastic, leather, and rubber wristbands. A spare stylus 
comes with the watch.

Where do I write Jot text on my Wrist PDA?
You enter Jot strokes right onto the Wrist PDA touch screen. The 
touch screen is divided into two sections, just like the writing area of 
other Palm OS devices. 
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Can my Wrist PDA use infrared for “beaming” 
with another Palm device?
Yes, the Wrist PDA has infrared beaming. It supports beaming, and 
HotSync operations via beaming, at distances no greater than one 
foot.

Battery Questions

How long does the battery last on my Wrist 
PDA?
The rechargeable battery on your Wrist PDA should last 3 to 4 days 
with an average of 30 minutes of PDA usage per day with no 
infrared port beaming and no backlight usage. This duration may 
vary depending on the amount of PDA usage, the temperature, and 
other factors.

Can I lose my data if the screen goes blank 
from not charging the battery? 
After the screen goes blank, the watch should retain data for about 
one day. Beyond this time, you would have to synchronize your 
watch with your PC to restore data.

How can I maximize the battery life?
There are several settings you can change on your Wrist PDA to 
help extend battery life:

• In the Wrist PDA preferences, set the Watch Mode App to 
None instead of Watch.

• In General preferences, set Auto-Watch After to the lowest 
setting and set Beam Receive to Off.

• Limit use of the backlight.

• Limit use of the infrared port.

• Try not to use processor and display intensive applications 
such as games.
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Operating Problems

I do not see anything on the Wrist PDA screen.
Your watch may be set to “sleep” with the screen off, or the batteries 
may need charging.

• Press and hold the Rocker switch for several seconds. If the 
display resumes, your Watch Mode App is set to None. You 
can change this setting in the Wrist PDA preferences.

• Recharge your Wrist PDA. If your batteries are too low, the 
screen will turn off to conserve power.

• If the display does not come back on after charging is 
complete, try performing a soft reset as described in the next 
section.

How do I reset the watch?
If your watch stops responding to the stylus or control buttons, you 
may need to perform a reset. See page 131. 

How do I open the software keyboard?
The keyboard is accessible as an icon on the command bar. Open the 
command bar by making a command stroke (a diagonal stroke from 
the lower left to the upper right) while the blinking text entry cursor 
appears. 
The command bar will remain open for 3 seconds. While the 
command bar is open, tap the keyboard icon.

You can also open the keyboard tapping the tab in the upper-left 
corner of the screen; select Edit, Keyboard. 

The software keyboard beeps, but does not 
display.
The software keyboard opens if there is a blinking text entry cursor 
in an area where text can be entered. Tap in the area where you wish 
to enter text. When you see a blinking cursor, try to open the 
keyboard again.
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I cannot get beaming to work with another 
PalmTM device.
• Make sure that the devices are 6 to 12 inches apart.

• Carefully align the infrared windows of the devices, making 
sure there are no obstructions between them.

• Try moving the devices closer to each other.

• Try different lighting conditions.

• Be sure that the receiving device has Beam Receive set to On 
in the General preferences settings.

I tried to perform a HotSync operation, but 
nothing happens.
• You must have the Wrist PDA USB drivers, Palm Desktop 

software, HotSync Manager installed on your computer, as 
described in the Getting Started booklet.

• You must be using Windows 98SE, Windows ME, Windows 
2000, or Windows XP.

• Check to make sure that the HotSync Manager is running. 
See page 112.

• If you are using a USB hub, connect the Wrist PDA directly to 
your computer’s USB port (not into the hub).
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